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ABOUT CLEARSPAN COMMUNICATOR FOR 
DESKTOP 

Clearspan Communicator for Desktop is a native Windows and Mac client for Unified 
Communications, providing the following communication features: 

• Instant Messaging and Presence (optional Clearspan features)

• Voice Calling (VoIP)

• Voice Calling (Desk phone)

• Video Calling

• Desktop Sharing (optional Clearspan feature)

• Clearspan Call Settings

This document covers the three versions of Clearspan Communicator for the Desktop: Audio, 
Video, and Lite. The Lite version allows you to place and receive calls through your desk phone 
using the desktop client. The Audio version of the client adds the ability to connect audio calls 
through the desktop interface, and the Video version adds the ability to have video calls.    

GETTING STARTED 

This section contains the essential information for getting started with Clearspan Communicator. 

INSTALLATION 

Your service provider provides the download of the installer. 

Windows 

• Double-click the installer executable and follow the installation instructions.

• Launch Clearspan Communicator.

MAC OS 

• Double-click the disk image.

• Copy the application into the Applications folder.

• Launch Clearspan Communicator.

SIGN IN 

When you first launch the application, you are prompted to sign in, and depending on your 
service provider settings, the login view is different. 

The login flow is as follows: 
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1. If displayed, enter the login Uniform Resource Locator (URL) provided by the service
provider.

2. Enter your Clearspan user name and password.

3. Select whether you would like Clearspan Communicator to remember your password.

4. Select whether you would like Clearspan Communicator to sign you in automatically on
subsequent launches.

5. Click Sign In.

When login regions are enabled by your service provider, the login flow is typically as follows: 

1. Select your region from the drop-down menu.

1. Enter your Clearspan user name and password (in PIV mode, only a PIN is needed).

2. Select whether you would like Communicator to remember your password.

3. Select whether you would like Communicator to sign you in automatically on subsequent
launches.

4. Click Sign In.

In Release 22.5.0 and later, depending on your service provider configuration, you may also 
have to enter your email address or access code with user name and password and after that 
select the IdP. 

 You can also access Help, Preferences, and login URL change view directly from the Login 
window. 

Note: If you choose automatic sign in, you are automatically signed in and taken to 
the Main window upon subsequent Clearspan Communicator launches. Otherwise, 
you are presented with the Sign In screen when launching the application. In the Main 
window, your default tab when signing in depends on service provider configuration; 
otherwise, Communicator remembers the tab you were on at sign out and opens that 
same tab at sign in. 

The Login window offers the last used username, but the password shall be automatically filled 
in only if you have checked the Save password checkbox.  If multiple people use the same 
machine, only the last password is entered as a security measure.  If you change the username 
in the Login window through editing it, or using the drop-down list to pick another one, 
Communicator will not fill in the password; you are always expected to type it in.  This also 
applies when re-selecting or re-entering the last used username. 

After logging in, a pop-up dialog may appear informing you about emergency calls and another 
about changing your location for emergency calls.  You may also see a banner in the Main 
window related to emergency calls.  Depending on your service provider settings, emergency 
calls may not be allowed.  In this case, calling an emergency number displays a pop-up dialog. 
A notification message in the Main window may also display. It is not a supported configuration 
to run multiple desktop clients at the same time with the same account. 

Note: It is possible to run several Communicator instances at the same time, but 
headphone connectors and Outlook integration may not work as expected. 
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MAIN WINDOW 

When you start Clearspan Communicator for the first time, your Contacts list is empty.  Use the 
Search and Dial field to find people and add them to your Contacts list.  Contacts can also be 
added manually by clicking the Add (+) button.  Client windows can also be set to be always 
using the main window menu option.  Note also, that depending on your service provider 
settings, the order of the left pane icons may vary.  The left pane call settings icon and menus 
are visible depending on your service provider settings.  The dial pad is also integrated with the 
Main window. 

Communicator windows open up in a cascaded fashion in the middle of the screen.  The Search 
and Dial field allows searching for contacts as well as making calls using phone numbers or SIP 
URIs.  SIP URIs must use the format user@domain or sip:user@domain. The table that follows 
the images describes the key icons used in the Main and Communications windows. 

My Information – View and update your information, for example, your presence, avatar, and 
location. 

Contacts – View your contacts. 

My Room – This is your permanent communication room.  Participants can dial in to your audio 
bridge. 

Communications History – View previous chats and calls. 

sip:user@domain
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Dial Pad – Make calls, integrated with the main window. 

Chat – Start an instant message conversation with a selected contact. 

Call – Make an IP audio call to a selected contact. 

Call from Phone – Make a Click-To-Dial call from your desk phone (or secondary device). 

Video Call – Make a video call to a selected client (VoIP). 

Web Button – Provides web content inside the Main window or browser. 

Preferences menu – Use for quick access to call settings such as call forwarding. 

Add – Add a contact, group, or conference. 

Share – Share either the whole screen or an individual application. 

My Information 

• Click the avatar to update your status or location and enter free text (native Desktop
only).

• Double-click the avatar to upload a picture or use a right-click menu.

• Right-click the avatar to update your status (native Desktop only).
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Presence 

You can set your presence to one status indicated in the following table. 

ICON WHAT IT MEANS 

Automatic presence:  This is the Available status where automated presence statuses such 
as Busy In-call override the Available status.  Requires newer presence server (aggregated 
presence) to show. 

The green presence icon indicates that the user is online and ready for communication.  This 
status is used until you change it and automated presence statuses such as In Call do not 
override. 

The yellow presence icon indicates that the user is online but has been idle or away from 
their computer for more than ten minutes. 

The grey presence icon indicates that the user is offline and the only available contact 
method is calling or leaving a chat message. 

The red presence icon indicates that the user is busy and does not want to be disturbed. 

This icon indicates that the contact is busy in a meeting.  This is an automated presence 
status.  The Busy – In Call status overrides the Busy – In Meeting status so this one is only 
seen if there is a meeting but no call. 

Communicator can automatically update your presence to the following: 

• Busy – In Call

• Busy – In Meeting (Windows only)

• Available (desk phone)

• Available (mobile)

• Away on mobile

• Offline and busy in call
You can set your Presence to Available, Away, Busy, and Offline. Clearspan Communicator can 
automatically update your presence to Busy--In a Call, Busy--In Meeting (Windows only), 
Available (desk phone), Available (mobile), Away on mobile, and Offline and busy in a call. 

Location 

Your location is automatically determined by your public IP address; however, if your system 
administrator has enabled it, you can manually set the text to appear for your location and time 
zone using the location dialog box. 

COMMUNICATIONS WINDOW 

After starting communication with one or more contacts, a Communications window is displayed 
for chat and may be displayed for calls depending on your service provider settings. The call 
window can also be integrated with the Main window. From this window, you can perform the 
following actions: 
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• Escalate a chat to include audio, video, and desktop sharing

• End an audio or video call

• Open the dial pad

• Mute your microphone

• Adjust your speaker volume

• Place a call on hold

• Transfer a call

• Toggle between speaker and headset.  You must specify different devices for a speaker
and a headset in Preferences to use this feature.

If you are using multiple monitors, Communicator opens the Communications window as well as 
notifications on the same monitor as the Main window. 

As of Release 21.2.0, Communicator limits the number of active communications to spare 
resources.  The limit is 20 active communications on Windows and on MAC OS.  If the maximum 
is reached, the main window’s top section warns you with the following message:  “The 
maximum amount of communication windows has been reached.  Please close some to open 
new ones.” 

If an incoming call is answered while this warning is shown, the client closes the chat session 
that has the longest time since its last activity. 

START CHAT 

Start a chat using one of the following methods: 

• Double-click a contact from the Contacts list or search results.

• Right-click one or more contacts from the Contacts list or search results and click the
Chat menu item.

• On the Chat History list, double-click a chat entry.

• In a Communications window, click the Chat button (this does not open a new tab).

• In the Main window, click the Add button and in the resulting tab click the Chat icon.

SEND FILE 

In a one-to-one chat, transfer files by clicking the Send File button in the Communications 
window or use the drag-and-drop method so that they are moved to the Communications 
window. 

SEND EMAIL 

Right-click a contact from the Contacts list or search results and select the Email menu 
option.  The contact must have an email address defined for this feature. 
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MAKE AUDIO OR VIDEO CALL 

Make an audio or video call using one of the following methods: 

• Right-click one or more contacts from the Contacts list or search results and select the
Call, Call from Phone, or Video menu item.  The menu items depend on service
provider settings.

• Right-click one or more contacts from the Contacts list or search results and click the
Call, Call from Phone, or Video. The menu items depend on service provider settings.

• Enter a phone number in the Search and Dial field.

- Press ENTER to start a VoIP call.

- Click the Call, Call from Phone, or Video button.

• Open the dial pad, enter a phone number, and then click the Call, Call from Phone, or
Video button.

• On the Call History list, double-click a call entry.

• In the Communications window, click the Call, Call from Phone, or Video button.

• When viewing a contact’s profile, click the Call, Call from Phone, or Video button.

Note: If dialing a phone number that requires additional dual-tone multi-frequency 
(DTMF) tones (for example, a conference bridge), you can type the numbers on your 
keyboard while the Communications window has focus or open the dial pad in the 
Communications window. 

SHARE YOUR APPLICATION OR DESKTOP 

Share your desktop by following these steps: 

1. Click the Start Sharing button in the bottom of the Communications window (if share
panel is not visible).  The Share button is visible by default in My Room also.  This button
is available when your service provider has enabled share on your account.  The share
selector window opens.

2. Select the application to share or the entire screen of a particular display and click the
Start Sharing button.

In addition, participants can share when enabled by their service provider. 

Note: To share your desktop, you must enter your web collaboration credentials in 
Preferences → Credentials, unless your service provider has automated provisioning 
in use.  For more information, see the Preferences section.  You can participate in 
desktop sharing sessions by another user even without having your own sharing 
credentials. 



Clearspan Communicator User Guide for Desktop R22.7.1 

9     |   Clearspan

ACTIVE COMMUNICATIONS 

Active communications appear at the top of the Contacts list in the main window.  This area 
provides an easy view to see the people with whom you are communicating.  By default starting 
in this release, the call window is shown in the Active Communications area in the Main window 
(where the call can be fully controlled in the desktop client).  It reduces the number of 
communications windows; however, a separate call window can still be opened using an Active 
Communications menu. The following is also available in this area: 

• Double-click an active communication item to bring this Communications window to focus
if the call window is separately shown. If the call window is integrated, you can use a
menu option to show it separately.

• See who has sent you a chat message, but only after you accept the chat session.
Before the chat session is established, the chat items are not visible in active
communications but a history badge is visible.

• End a call.

• Mute the microphone.

• Place a call on hold.

• Merge two calls or transfer by dragging and dropping calls onto each other.

• Transfer a call.

• Make conference calls.

• See call recordings.

• Park and retrieve calls.

As a service provider option in Release 20.2.2 and onwards, more buttons can be added to the 
active communications area: 

• Conference

• Call transfer

• Call park

• Call Pull

When enabled, you can use the buttons for faster access to the services. 

You can right click the “More” icon of an Active Communications item (icon with three dots) 
for additional options while left click offers additional call management options for this call as 
well as other options when available. 

MY ROOM 

My Room is an always available and permanent room you can use to chat with anyone that 
joins. 
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If you assign a conference bridge to your profile in Preferences → Credentials, then in your 
room, you and your attendees can click the Call or Video button to have Clearspan 
Communicator automatically dial in to the conference and enter the appropriate entry codes.  
Note, if your service provider has auto-provisioning enabled, then you cannot edit these details.  
If your service provider has silent dialing enabled, then you cannot hear any DTMF tones when 
dialing into My Room (the call is made automatically). 

If a conference bridge is not specified, you cannot initiate a call in your room.  Clearspan 
Communicator dials out to all participants and takes everyone off hold after the last attendee 
answers. 

You can invite others to your room by dragging and dropping them from the Contacts list into the 
My Room Communications window.  You can also use the right-click menu on the My Room 
icon in the Main window or the menu icon in the My Room information area to copy an invitation 
link for guest users (people without Communicator).  They can then click the link and join the 
meeting through a web browser.  Guest users must be separately accepted for each session. 

Contacts join your room by right-clicking your name on their Contact list and selecting Join 
Room or by an invitation you sent. 

Email My Room Invitation menu results in working links for guest users only Communicator 
users are recommended to use “Copy Guest Link” invitation links; however, the btbc link part 
links when enabled by your service provider may not work in all applications as they were 
originally intended for Outlook. 

You can also export the attendee list using the related participant menu available via the options 
icon (three dots). 

In My Room calls, the owner can also see active speaker info with the Mute/Unmute icon. 

My Room and Desktop Sharing are optional Clearspan features. 

SELECT AUDIO DEVICES 

If you have multiple audio devices available for your microphone or speakers, select the 
preferred audio device before starting a call. 

Windows 

1. Click the Clearspan Communicator logo in the main window title bar.

2. Select Preferences.

3. Select Audio.

4. Set a playback device (speakers).

5. Set a recording device (microphone).

6. Click OK.

MAC OS 

1. Select Clearspan Communicator from the main menu.

2. Select Preferences.

3. Select Audio.

4. Set a playback device (speakers).
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5. Set a recording device (microphone).

6. Click OK.

If “Use default” is selected, then Clearspan Communicator uses the default device set in the 
operating system preferences.  For Windows, if “Default Communication Device” is defined, it is 
selected over the “Default Device”. If you are using headsets, you can also select a separate 
device than the headset for alerting incoming calls. 

Note that on MAC OS it is recommended to disable “Use ambient noise reduction” in System 
Preferences to reduce echo. 

CONTACTS 

Contacts are the people with whom you communicate and, in most cases, you see their 
presence and share your presence with them.  There are three types of contacts: 

• Contacts – Actual people with whom you communicate.

• Conferences – Audio or video conference bridges that you use to communicate with
others. Silent dialing into the bridge also applies to these contacts if enabled by your
service provider.

• Groups – Containers of contacts and/or conferences.

There is no hard coded limit on the number of contacts.  The more contacts are added the more 
memory and processing is needed.  The more contacts are added, the more difficult it is to find 
people without searching.  Live search can be used instead of a very large local contact list while 
keeping memory and processing requirements to a minimum. 

ADD 

When you sign in for the first time, there are no contacts on your contact list.  Add a new contact 
at any time by selecting the Add Contact item from the menu or choose the Add (+) button from 
the main window. In the resulting tab, you can select to add a contact, group, or other items. 

In the Add Contact dialog box, enter the contact’s information and then click Add to Contact 
List checkmark.  By default, your presence information is always shared with a new contact if an 
Extensible Messaging and Presence Protocol (XMPP) address is provided. 

If you are accepting contacts via a buddy request, you may see the contact card after accepting 
the buddy request, depending on the service provider settings. When receiving a presence 
request, there are two buttons for accepting and rejecting the request.  Dismissing the presence 
request window only ignores the request for the duration of the login session.  It reappears after 
the next login. 

However, you can always share your presence information later by selecting Subscribe on the 
right-click menu for a specific contact on the contact/directory list.  Note that the contact must 
accept your subscription request for you to establish the presence relationship successfully. 

The newly added contact appears on your contact list. 

Add a conference contact by clicking the same button you did for Add Contact and choosing the 
Add Conference Contact menu option.  A conference contact is a special contact used for 
conference bridges to avoid remembering PIN codes and conference number, for example, 
recurring conferences.  Just create a contact for the weekly conference, add a conference bridge 
number and PIN, and join the conference just by right-clicking the contact or choosing it and 
clicking the Call button. 
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Choose the Add Group menu option to add a new group to the contact list. 

Contact card telephone number fields can also have SIP URIs (work, mobile, extension, 
personal, and conference bridge).  Release 21.5.0 introduced support for additional contact card 
fields. 

EDIT 

Edit a contact by selecting the contact first.  After you select the contact, right-click anywhere in 
the area of the selected contact and a menu of options appears, which allows you to either view 
or edit the contact profile.  In View mode, click the Edit button to go to Edit mode.  This base 
principle is the same for normal contacts, conference contacts, and groups. Note that depending 
on your service provider settings, all or no contact card fields may be editable.  Depending on 
your service provider settings, you may also see a button for synchronizing the contact card with 
the Telephony directory or the synchronization may take place automatically.  When the manual 
synchronization button (cloud icon) is visible, there is no automated syncing of the contact card 
details with server information.  To synchronize the contact card data, click on the cloud icon. 

• Unsubscribe removes the presence relationship between you and that contact.  This
means you do not see the contact’s presence information and your contact does not see
yours.  To re-establish the presence relationship, select Subscribe.  An unsubscribed
contact remains on the contact list and is always shown without an icon.  Any contact that
is not presence-enabled is shown in the same way.

• Delete contact removes the contact from your contact list.

• View Profile opens the Contact Information dialog box where you can add, edit, or
remove information.  This works for both normal and conference contacts.

• For groups, choose the Edit menu option to rename a group.

Once done with all changes, click the Save button. 

FILTERS 

You can filter contacts in two ways: 

• Use the filter field to search by contact name.  The contact list is filtered in real time as
you type.

• Alternatively, use the filter menus available by right-clicking the Contacts icon in the left
pane to display only specific types of contacts such as online contacts.  You can also sort
contacts based on first or last name or choose whether to display the contact’s avatar
and availability status in the contact list.

Favorite filtering works slightly differently in this release: 

• When you make a contact your favorite, the favorite group shows on top of the contact
list and cannot be hidden.

• When you delete all your favorite contacts, the favorite group does not show anywhere.

• When you have even one favorite marked, you see the group.
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PRESENCE 

Instant Messaging (IM) and Presence (P) are optional Clearspan features. 

For each contact you have subscribed to, you can see their presence.  Similarly, your contacts 
can see your presence on their contact list. 

Presence means that your friends are able to see whether you are available to communicate, for 
example, “I’m busy” or “I’m available”. 

ICON WHAT IT MEANS 

Automatic presence:  This is the Available status where automated presence statuses 
such as In-call override the Available status.  Requires newer presence server to show. 

The green presence icon indicates that the user is online and ready for communication. 

The yellow presence icon indicates that the user is online but has been idle or away from 
their computer for more than ten minutes. 

The red presence icon indicates that the user is busy and does not want to be disturbed. 

The grey presence icon indicates that the user is offline and the only available contact 
method is calling or chatting. 

The question mark indicates that a subscription is pending and the contact has not yet 
approved sharing their presence. 

This icon indicates that the contact is busy due to a call.  This is an automated presence 
status. 

This icon indicates that the contact is busy due to a meeting.  This is an automated 
presence status.  The Busy – In Call status overrides the Busy – In Meeting status so this 
one is only seen if there is a meeting but no call. 

This icon indicates that the contact is only available on mobile Clearspan Communicator. 

This icon indicates that the contact is only available on a compatible desktop phone, not 
Clearspan Communicator. 

This icon indicates that only the mobile client is online and in the away status.  

This icon indicates that the user is in a call but is not logged in to XMPP (presence and 
chat).   

The avatar in this version is not completely in real time.  The avatars are retrieved at login, when 
the contact is added, and when the contact comes online. 

Double-click the avatar to change it.  A File Explorer view opens. 

If you see an error message at the top of the Main window “XMPP Unavailable”, it means that 
the XMPP connectivity has been lost for chat and presence; however, you can still make calls.  
You should contact your service provider. 

Have the Outlook calendar automatically change your presence to Busy – In Meeting by 
enabling this in the Preferences → General tab. 
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The presence update is only triggered by appointments and meetings that are in the Show me 
as busy state 

The XMPP address of a contact cannot be changed.  Instead, you must delete the old contact 
and create a new one. 

Location in presence is done based on the IP address that the machine is using.  The IP 
address is mapped to a physical location. If the system administrator has made it configurable, 
you can configure location information by clicking your Presence indicator and then clicking on 
your location.  

Snapshot of presence status is also available in search results and Communications window for 
contacts who are not buddies.  This presence status is not updated after the search is done or 
after the communications session is set up. 

AUTOMATED PRESENCE 

As a service provider option starting in Release 22.5.0, automated presence may be used.  
When used, contact addition no longer uses a buddy request dialog instead all presence 
subscriptions are automatically accepted by the network.  This results in asymmetric presence 
relationships where you see the presence of the contacts you have added but they do not see 
your presence until they add you as a contact.  This feature requires a newer server version 
(aggregated presence) to show. 

CHAT 

CHAT VIEW 

Instant Messaging (IM) and Presence (P) are optional Clearspan features. 

When you initiate a chat, the Chat window opens.  Chatting with a contact is possible only when 
you are both online.  If your contact initiates a chat, you see a pop-up notification in the bottom 
right-hand corner of the screen.  If you close the Chat window and open it again, sent chat 
messages are shown in the window as chat history. When enabled by your service provider, a 
typing notification is also shown. 

When the chat opens, you see the contact’s information at the top of the screen.  If you want to 
use the whole area for writing, you can press the background of the information or the top bar.  
You can contract or expand the information of the contact during the chat and you can leave it 
open or closed depending on your preference. 

At the top of the message area, there are four links:  Yesterday, Last week, Last month, and All 
history.  From these links, you can load history from your local storage and different time frames.  
You can delete the history using the drop-down menu. 

In the text field, you can add a smiley emoticon.  Smiley emoticons can also be added by 
manually entering the corresponding characters that represent that particular emoticon.  You can 
send text by pressing ENTER. 

The full set of Emojis is also supported and they are rendered as ordinary emoticons when 
received.  Spell checking in US English is also supported and can be disabled in Preferences.  
The implementation of Emojis is different between Releases 22.1 and 22.4 and later so sending 
Emojis between those may not fully work.  For troubleshooting tips, see section Troubleshooting 

To enter a line break in the text field, you can use the following key commands: 

|   Clearspan 
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• CTRL+ENTER (COMMAND+ENTER on Mac)

• SHIFT+ENTER

• ALT+ENTER

Use either one of the short commands, CTRL+C or CTRL+V, or right-click the selection for a 
menu to copy or paste the text to or from the Chat window. 

It is also possible to chat with users in other domains.  BroadCloud also supports Google 
federation.  Group chat is not supported in Google federation, so the group chat option with 
these contacts is shown in grey. 

All sent and received chats are stored locally in the chat history and an optional message history 
feature provides multi-device enhancements so that messages sent or received in other own 
devices would also be shown. 

Depending on your service provider settings, older chat messages may be automatically 
deleted.  In this case, the history links in the top area of the Chat view are automatically 
adjusted. 

FILE TRANSFER 

File transfer functionality is accessible only through the Chat window. 

1. To open the File Selection dialog box, click the Send File button located to the side of the
text field.

2. Select the file to be sent from the dialog, and then click Open.  You can also drag and
drop a file into the Chat window.

3. Once the file offer is issued and during its transfer, you can cancel the transfer (at any
time) by clicking Cancel.

4. Accept an incoming file transfer by clicking the Accept button.

5. Reject the file transfer offer by clicking the Decline button.

After the file transfer has completed, the received files can be opened or viewed in the file 
manager by using the File received, click to open, and Show in folder links. In error situations, 
partially received files are not deleted automatically. 

GROUP CHAT 

Start a group chat by “multi-selecting” and right-clicking the main window contact list.  More 
people can be added later to the chat by drag-and-drop.  Only the owner can add more 
participants. Depending on your service provider settings, the right-click menu items may differ.  
Newer group chat deployments only have the My Room right-click menu item available for calls. 

A group chat works the same way as a one-to-one chat.  All messages from anyone are sent to 
everyone else.  All contacts need to be online to be able to participate in a group chat.  You 
cannot invite an offline contact or a contact that is not on a device that supports group chat.  This 
does not affect the group chat in any way. 

A group chat history is saved both in My Room and in ad hoc chat rooms and is available to view 
later in the Messages tab of the main window. 

In the text field, the contacts’ names appear in different colors to easily distinguish between who 
is writing. 
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Only the newest chat room messages are stored on the server.  One-to-one chat messages are 
only saved locally. When the optional Message History feature is enabled by your service 
provider, messages sent from your other devices are also shown. 

Deleting a chat room is not supported. 

Chat rooms can be moderated by the owner.  Use the right-click menu options to remove a 
participant from your chat room.  If needed, the removed participant can join later.  The removal 
also applies to desktop share sessions. Typing notifications are not supported in group chats. 

Typing notifications are not supported in group chats. 

CHAT RECORDING 

Chats can also be recorded as a service provider option; in this case, the client shows a 
recording indicator.  Note that there are no end-user controls for chat recording. 

AUDIO AND VIDEO CALLS 

The following table describes additional Communications window icons and explains what you 
can do with them, for voice and video calls. 

ICON WHAT YOU CAN DO 

Enter additional digits using the dial pad at any time during the call (for 
example, to insert a conference number).  The dial pad is not movable. 

Mute your microphone by clicking the mute icon. 

Adjust the volume bar to adjust the volume.  Dragging it all the way to the left 
mutes your speakers.   

Use this icon to access the Call Options menu.  In the Call Options menu, 
you can find different actions to use for a call depending on your settings 
and your service provider. 

Add or remove video from the call. 

Use this icon to access the Call Options menu.  In the Call Options menu, 
you can find different actions to use for a call depending on your settings 
and your service provider. 

In the Options menu, there are the following options: 

• Transfer a call to a third party.

• Put the call on hold.  Note that if you hold the call, the other party cannot “unhold”.  This
freezes a video call to the last frame of the video feed.  In both voice and video calls, this
is communicated to all parties by a notification appearing in the middle of the screen.

• Adjust the volume bar to adjust the volume.  Dragging it all the way to the left mutes your
speakers.



Clearspan Communicator User Guide for Desktop R22.7.1 

17     |   Clearspan

• Enter additional digits using the dial pad at any time during the call (for example, to insert
a conference number).  The dial pad is not movable.

• Toggle between the audio headset and speakers.  You must specify a different device for
a headset and a speaker in Preferences to be able to use this feature.

• Add participants to the call.

As an alternative, in general available Feature Access Codes (FACs) for call management 
work during calls, for instance *55 for direct transfer to voice mail, but the ongoing call must 
be put on hold and a new call must be made to the FAC ”number”.  Using DTMF for the same 
purpose does not work. 

When establishing a call to a contact, you can choose several ways to call.  Select the 
contact you wish to call and press the Call icon.  This calls the default number.  If you right-
click on the contact you wish to call, you can choose the number to call from a right-click 
menu.  There can be several phone numbers available in the menu.  The work phone is the 
default and top most number is followed by mobile and other numbers.  This also applies to 
the transfer and conference windows.  However, in certain cases the transfer/conference 
default number can differ from other call options in other menus. 

The default call type can also be selected using accessibility menus (Calls → Dialing 
service).  This controls the default call type when using call buttons. 

Dial a number or SIP URI of format user@domain or sip:user@domain in the combined Search 
and Dial field to make a call.  Once you type your numbers, Clearspan Communicator searches 
for contacts on both the local contact list and the enterprise directory. 

You can also call circuit-switched network numbers such as Global System for Mobile 
Communications (GSM); however, this depends on the service provider network you are using; 
there is no technical limitation. 

Choose your video size from the Preferences and the Video tab.  Your selection is used by 
default for future video calls.  The available sizes are automatically presented based on your 
camera.  You cannot have two simultaneous calls with the same person. 

Communicator does not add video to an audio call without end-user consent.  This also 
applies to blind video call transfer cases where audio-only music on hold is used; this may 
result in the transferred call being reduced to audio. 

You can also see a secure call icon when an encrypted call is taking place. 

There is sleep prevention during calls. 

CALL FROM YOUR COMPUTER 

Select a contact from your contact list to start communication and click the desired 
communication button.  Type a phone number in the Search and Dial field at the top of 
Clearspan Communicator window (search or communicate), to communicate with someone who 
is not on your contact list. 

CALL FROM PHONE 

The second option to communicate in the row of communication buttons is the Call from Phone.  
When you click this button, the desk phone instantly starts ringing and the call is established 
from your desk phone.  This depends on your service provider configuration as other devices 
may also ring. 

sip:user@domain
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When your service provider is configured to also initiate a call from computer (SIP call) to the 
same machine that initiated a call from phone, that incoming (SIP) call will be accepted and will 
alert if it does not have the same identity as the call from phone. 

For remote calls initiated using the Clearspan Communicator, you can also have mid-call 
controls such as hold/resume, transfer, and add participant. 

Automatic Busy – In Call presence also works with the Call from Phone feature. 

Depending on your service provider settings, it is also possible to control calls initiated without 
Communicator in the Active Communications view.  The same mid-call controls are also 
available in this case.  In case of an incoming call, the actual answering action must happen with 
the other device. 

ANSWER CALL 

When someone is calling you, you see a pop-up notification on your screen.  You can choose to 
answer, silence the incoming call, and then open a chat session with the caller, reject the call, or 
silence the incoming call by closing the pop-up notification window.  If you silence the call, the 
ringtone is silenced but the caller does not see anything on their end.  You can answer or reject 
the call after silencing it only if you have chosen the chat option.  If you close the incoming call 
pop-up notification to silence an incoming call, then you do not have an option to answer or 
reject it any more. When choosing the chat option, chat is only enabled after the call has been 
answered or rejected. 

If you reject the call, it causes the line to sound busy at the caller’s end and they know that you 
rejected the call. 

When someone is calling you with a video, you see the same pop-up notification; however, the 
options are answer with video, answer as voice only, silence and chat, reject, or silence (by 
closing the pop-up window).  If you decide to answer as voice only, the call is voice only. 

CONTACT NAME LOOKUP FOR INCOMING CALLS 

Clearspan Communicator performs a local contact search for incoming calls.  If the number 
matches one of the contacts on the Clearspan Communicator contact list, the name is shown on 
the incoming call screen along with the alert. Both the display name and phone number are 
shown when available. 

If there is no match to a local contact, Communicator looks for a match in the Telephony 
Directory, and if a match is found, the available information is shown for the incoming call.  If 
there is no match in the Telephony Directory, the display name is taken from the available 
information in the incoming call. 

Whenever you retrieve your call logs/history, Clearspan Communicator does a lookup in the 
local contacts and populates the name if a match is found. 

MISSED CALL OR COMMUNICATION 

When you have one or more missed calls or other types of communications, there is a 
notification on the left-hand side of the navigation pane in the main window.  Clicking the icon 
takes you to the missed communication in the Communications History view. 

FULL SCREEN IN VIDEO CALL 

Full screen mode can be activated by clicking the Full Screen button or by double-clicking 
anywhere on a video. 

|   Clearspan 
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Exiting full screen mode is done by pressing the ESC key  (on both Windows and MAC OS) or 
by double-clicking the window.  Exiting full screen makes the video call go back to its original 
state (even if there was resizing of the window previously before going full screen). 

In a full-size window, you can see a similar Options menu at the top.  It has the same 
functionality as it does in the normal view.  When you move the mouse, the top bar and lower 
communication buttons appear on top of the video. 

MULTIPARTY SESSIONS 

You can have many participants in a call, either in a My Room or in an ad hoc multiparty call 
(native Desktop only).  Add more participants by dragging and dropping them on to the 
Communications window or by selecting the Conference menu item via the Communications 
window menu button.  By choosing the menu item, you can also add participants with just a 
telephone number.  Starting with Release 22.2.0, ad hoc multiparty calling is slightly different in 
that each call party must be separately merged onto the call to be able to terminate failing calls 
to, for example, voice mail. 

In contrast to using My Room, which uses your permanent chat and collaboration rooms and 
conference bridge, you can start ad hoc multiparty sessions by either selecting multiple contacts 
on the contact list and starting a chat, by calling them, or by expanding a one-to-one session into 
a multiparty session by dragging and dropping a contact into the Communications window.  In an 
ad hoc session, the room used is a temporary one that is deleted once the session ends (that is, 
when the last participant leaves).  Voice conferencing does not use a bridge but instead uses the 
Clearspan  
N-Way Calling supplementary service in a sequential fashion. Communicator dials out to all
participants and takes everyone off hold after the last attendee answers.

In newer deployments with the Video Server (UVS), the ad hoc room created for the session has 
a limited lifetime and becomes inactive when idle for too long.  In this case, participants are able 
to rejoin the ad hoc session if they drop out for some reason.  A consequence of this is that, in 
ad hoc group calls, participants who are no longer in the call are still visible in the participant list. 

If the XMPP service is not available, then ad hoc multiparty calls are not available. 

CALL WAITING 

You can have one active call at any one time if you receive a new incoming call and accept it.  
The existing call is put on hold and you can change between these two calls by using the Hold 
and Unhold buttons. If Call Waiting is in the ringing state then new incoming calls are rejected. 

CALL TRANSFER 

Blind call transfer is available in the Communications window; choose the Transfer Call menu 
item to transfer the call to someone else.  Attended call transfer is also available in the same 
window, first call someone to check if the called party can take the incoming call and then 
transfer the incoming call to the desired called party. You can also search for the transferred-to 
party. 
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MESSAGE WAITING INDICATION AND VOICE MAIL 

Depending on your service provider settings, you can have either Visual Voice Mail (preview 
feature) or Message Waiting Indication (MWI) view in your client. 

The Message Waiting Indication (MWI) service allows you to receive a notification for a waiting 
voice mail or video mail.  By clicking on the message icon in the upper right-hand corner of the 
main window, Clearspan Communicator calls the predefined mailbox number to allow the user to 
listen to the voice mail or view the video mail. 

It is also possible to call voice mail from the dialer by long pressing the “1” icon in the dialer. 

When visual voice mail is enabled, a third tab is available, showing visual voice mails.  Click on 
individual mails to listen to them.  Video mail is supported as a preview feature if enabled by 
your service provider.  The current design is that listening to the visual voice mail or marking it 
as read decreases the unread messages badge while just doing a single click does not.  Visual 
voice mail view also indicates if the message is urgent or confidential. 

Missed calls are indicated by an icon in the main window.  Missed video and audio calls are 
indicated with a different icon.  Note that the MWI icon is in the same place when it indicates a 
new voice mail. 

Visual voice mail is also supported when enabled by your service provider.  You can see all 
voice mails in a list and play them inside the Main window. 

The following settings are needed on CommPilot portal to have visual voice mail: 

• Voice messaging enabled

• “When message arrives, use unified messaging” option enabled

• “Use Phone Message Waiting Indicator” option enabled

Auto-deleted voice mails are cleaned once a day. 

CALL PARK AND RETRIEVE 

Call Park is particularly suited for shared environments where one person can answer the call, 
park it, do something else for a while and continue the call from another device or let somebody 
else continue the call. 

Transfer an ongoing VoIP call to a Call Park server and then retrieve it when needed.   
An ongoing call can be parked against your own number or another number (an extension).  Call 
Retrieval works in the same way, the parked call can be retrieved from your own number (an 
extension) or another number (an extension) to provide flexibility for who is picking up the 
parked call. 

A parked call is visible on your desktop in the active communications area so that you can easily 
retrieve it, but only for the duration of the Clearspan Call Park announcement.  After the 
announcement is over, the parked call disappears from the active communications area (since 
the triggering call is disconnected).  After the call disappears from the active communications 
area, the user must remember the extension to which the call has been parked to retrieve it 
using the main window menu (or feature access code), unless the call was parked to the one’s 
“own” extension.  If the call is not retrieved after a certain time, then the server calls the parking 
user. 

|   Clearspan
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CALL PULL 

Call Pull allows you to pull an ongoing call from one of your devices to another one where the 
Call Pull feature is used.  Call Pull can also be used with feature access codes (FACs), in this 
case, *11.  In this release, user interface support has been added to the desktop so that an end 
user does not have to remember FACs. Release 22.2.0 added support for the Call Pull button for 
Xsi calls as well. 

CALL RECORDING CONTROLS 

You can use call-recording controls in this release.  Depending on your service provider’s 
configuration, call recording can be initiated when a call starts or dynamically during a call (and 
start, stop, pause controls may be available).  Additionally, there is an audio indication that call 
recording is ongoing as well as a visual indication.  Feature access codes can also be used to 
control call recording when enabled in the configuration. 

Recorded calls are accessed outside of Clearspan Communicator; that is, you cannot view them 
using the client. 

Depending on your service settings, Call recording behavior is one of the following (this cannot 
be controlled in the client but in the self-provisioning portal): 

• Always – recording indication (icon) in the Communications window as well as the Active
Communications user interface (UI).

• Always with pause/resume – recording indication (icon) in the Communications window
as well as in the Active Communications UI (only pause/resume menus available).

• On demand – recording indication (icon) in the Communications window as well as the
Active Communications UI (no stop menu available, only start and pause/resume).  After
a call is established, call recording starts on the server.  If the user presses the Start
Recording button during the call, the call recording is stored and the server keeps the
recording of the whole call regardless of when the recording was started (except for
pauses).  Otherwise, if no start recording is initiated from the user, the call recording is
deleted from the server.

• On demand with user-initiated start – recording indication (icon) in the Communications
window as well as the Active Communications UI (menu options available for start, stop,
and pause).  Call recording can be initiated at any time and several times during a call.
There are separate call recordings for each call recording startup.

• Never – no indicators or menu options present.

Pause/resume audio indication depends on your service provider settings.  It is recommended to 
log back in after changing the call recording mode in the self-provisioning portal. 

MODERATOR CONTROLS 

You can control the functionality available to participants if you are the owner of the session in 
My Room.  You can do the following: 

• Dismiss one or more participants. This ends all sessions (group chat, audio, video, and
share) when the participant is using Communicator for Desktop.

• Mute one or more participants.

• Lock or unlock the room (when locked no additional participants can join).



Clearspan Communicator User Guide for Desktop R22.7.1

22     |   Clearspan 

• See active talker indication.

• See full audio participant list.

• Choose who can join without separate authorization (moderated My Room):

o Require only guests to request access

o Require everyone to request access

o Allow everyone to join automatically

To invoke the features, you can use either the right-click menus or you can click on the 
moderator control icons of a participant.  Note that most features are not available via icons.  To 
dismiss or mute all participants or lock the room, use the right-click menus available for your own 
icon at the top of the participant list. 

If you are not the owner, you can only see the XMPP (chat) participant list or the full participant 
list along with mobile participants (depending on your service provider settings. 

FORCED LOGOUT 

Depending on your service provider settings, you may see a pop-up saying that you have been 
logged out due to another instance of the client logging in.  This feature allows Clearspan to 
track similar online client instances and only allow one of them to be online at the same time.  
When Clearspan notifies the client to log out, all connections are terminated, and client returns 
to the login window. 

ECHO (TEST) SERVICE 

Use this Main window menu option to make a test call to verify voice and video quality.  The 
echo service asks you to record a message and plays that message back immediately before 
hanging up.  The echo service may be available in different languages depending on your 
service provider settings. 

HEADSET SUPPORT 

You can control incoming and ongoing calls from a compatible headset.  The feature set 
supported is answer/hang up as well as mute/unmute.  Volume control operations are not 
reflected in the Communicator UI. The following is a list of tested example devices, although 
other devices should also work: 

• Plantronics Voyager Edge UC

• Plantronics Savi 700 series

• Plantronics Blackwire C3xx, C4xx, C5xx, and C7xx

• Plantronics Calisto 620

• Plantronics Voyager Legend UC

• Logitech H570e Mono

• Logitech BCC950

• Logitech Conference Cam Connect

• Jabra Biz 2300/2400
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• Jabra Speak 510

• Jabra Pro 930 (wireless)

• Sennheiser SC 230/260

• Sennheiser SP 20

• Sennheiser MB Pro1 UC

Headsets typically use an add-in of some kind to communicate with the rest of the client while 
calls are made.  Currently, installed add-ins are visible in Preferences Add-ins tab. 

In addition to the standard HID add-in, headset vendors may develop their own add-ins that will 
replace the standard HID add-in for all devices.  These vendor-specific add-ins would be 
installed during new headset installation; however, the standard HID add-in should remain in the 
preferences list.  If for some reason it has disappeared, adding the respective .dll file back to the 
add-in folder should make it visible again in the preferences.  If later on you would like to change 
to another headset, the vendor-specific add-in could be disabled from preferences to again use 
the standard HID or some other new add-in by another headset provider. 

These vendor-specific add-ins are typically installed during new headset installation; however, 
the Standard HID Add-in should remain in the preferences list.  If for some reason it has 
disappeared, adding the respective .dll file back to the add-in folder should make it visible again 
in the Preferences.  If later on you want to change to another headset, the vendor-specific add-in 
could be disabled from Preferences to again use the standard HID or some other new add-in by 
another headset provider.  Re-login is necessary to take the new add-in into use. 

Some USB headsets may have additional functionality offered by the vendor-specific add-in 
such as answering the call directly when taking the USB headset off dock.  See the USB 
headset documentation for details of such functionality. 

If you are using many different headsets, the Standard HID Add-in offers a default add-in that 
can always be used. 

The following is the default Add-in folder location (note that it is not possible to write to this 
location in all systems): 

• Windows 7/Windows 8/8.1/10:  C:\Program Files (x86)\broadsoft\Clearspan
Mobile/Tablet\connectors

Uninstallation does not remove add-in DLLs.  In general, the following steps could be 
followed with third-party add-in DLLs. 

1. Make sure that both Clearspan Mobile/Tablet and the third-party add-in are installed.

2. Go to Clearspan Mobile/Tablet → Preferences → Extensions.

3. Enable your add-in of choice, either USB Device Add-in or a USB headset vendor-
specific one.

4. Restart Clearspan Mobile/Tablet to take the changes into use.

TEAM TELEPHONY (BLF LIST) 

Team telephony is comprised of a team telephony window showing the predefined team 
members and their related call states.  For a ringing call, the only action is to pick it up. 
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Each team telephony member can have four call states:  available, busy in call, ringing, and 
offline.  The status for a team telephony member is shown in the team telephony window.  When 
a line is ringing, you can see the caller ID in the respective lines tooltip if configured by your 
service provider.  All team members can see the full list of team members in the team telephony 
window.  A double-click on the team member performs the default action towards the contact.  
You can drag and drop people from the contact list to the team telephony window or vice versa 
to transfer or conference calls. 

The corresponding server side service must be provisioned and assigned by the service provider 
for the client to work.  Usual call management options are available once the call has been 
answered. 

EXECUTIVE-ASSISTANT 

The Executive-Assistant service allows an assistant to operate on behalf of an executive to 
screen calls, answer calls, and place calls as the “executive” (the caller ID is the one of the 
executive).  The provisioning of the executive and assistant roles takes place on the server side 
and cannot be modified on the client. 

One assistant can have many executives and it is possible to: 

• Select the desired role when making a call using a pull down menu in the Main window.

• Answer an incoming call on behalf of an executive and then push the call to the
executive.  The incoming call is presented as a call to the executive.  In addition, all the
usual call management options are available.

• See that an incoming call is actually for the executive.

The caller ID format is dependent on your service provider settings and cannot be changed on 
the client side. 

PRESENCE RULES AND SILENT ALERTING 

Starting with Release 21.2.0, you can combine call processing with presence statuses.  For 
instance, “Busy” state can be combined with call forwarding so that when the “Busy” presence 
status is used, calls are forwarded.  It does not matter how the presence status is invoked, via 
automation or manually. All presence statuses can have presence rules: 

• Available

• Busy

• Away

• Offline

The following Clearspan call processing services can be used: 

• Silent alerting

• Call forwarding to number

• No rules

If presence rules are used, all your client devices should have this service enabled to avoid side 
effects.  Silent Alerting is supported whenever an incoming call has that feature enabled.  Silent 
alerting can only be enabled via presence rules in Communicator but various settings can also 
be altered via web provisioning. 

|   Clearspan 
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PERSONAL ASSISTANT 

Starting with Release 22.5.0, when enabled by your service provider, Personal Assistant allows 
you to use and configure additional predefined presence status to specify how long the status is 
enabled, what is the call transfer number for incoming calls during that status, and if ring splash 
is used. 

Ring splash (Silent alert) plays a short audio tone on your desk phone when an incoming call is 
transferred.  Your presence status with its duration is also played out to the caller when these 
additional presence statuses are used. 

Supported new statuses are: 

• Business Trip

• Gone for the Day

• Training

• Lunch

• Meeting

• Temporarily out

• Out of Office

• Unavailable

• Vacation

When the duration for the selected presence state is set to last “End of day”, Communicator 
sets the expiration to the next day in the morning at 8 A.M. (0800 hours).  Note that your OS 
locale defines the language in which the day is shown in the Personal Assistant status “Gone 
for the Day”. 

The following table depicts the default validity times for the presence statuses. 

PRESENCE STATUS DEFAULT DURATION 

Business Trip 

End of the Day Gone for the Day 

Training 

Lunch 

1 hour Meeting 

Temporarily Out 

Out of Office 

Never Unavailable 

Note that contact list entries do not show the end time, by default, but you can see the information 
using tooltips (that is, by hovering over the contact). 
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Release 22.7.0 added support for the “Alert me first” option where you can specify how many rings 
the incoming call alerts in your Communicator client before proceeding to follow the Personal 
Assistant rules.  Additionally, depending on your service provider settings, the “Silent alert” setting 
(ring splash) may or may not be hidden when you are managing Personal Assistant statuses such 
as “Gone for the day”. 

CALL CENTER AGENT LOGIN 

Starting with Release 21.2.0, you can also log in to your call center queues if you are a call 
center agent.  You can do the following: 

• View your call queues.

• Join your call queues.

• Set the Automatic Call Distribution (ACD) status so that you get incoming call center
calls.  However, this is dependent on your license settings.

With suitable ACD status such as “Available”, incoming calls to the queue are routed to your 
client.  With “Unavailable” ACD status, Clearspan Do Not Disturb (DND) state can also be 
selected or “Personal Call”.  Each ACD status indicates with text if you are to receive incoming 
call center calls. 

Dynamic ACD status updates are not supported if the ACD status is changed somewhere else. 

REMOTE CONTROL EVENT PACKAGE 

Remote Control allows you to answer a call or put it on hold from a receptionist or call center 
client while the results are seen in your Communicator desktop client.  Answer and hold/resume 
buttons are visible in Receptionist/thin client to perform call management operations. 

This feature must be enabled by your service provider for it to be used. 

AUTO-ANSWER 

Release 21.5.0 introduced support for auto-answering incoming SIP calls for call center 
scenarios.  The incoming call notification is identical to the usual incoming call notification. 

WEB POP 

Starting with Desktop Release 21.6.0, web pop allows you to get more information about an 
incoming call by clicking on the web pop button of the incoming call toaster.  You can also do the 
same for outgoing calls using menus. 

This opens your default web browser with a predefined URL that provides more information 
about the other party. 

You can also change this URL in Preferences, if allowed by the service provider. 

This feature is not available for Team Telephony or the assistant in Executive-Assistant calls. 

|   Clearspan
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HIDE COMMUNICATIONS WINDOW NOTIFICATIONS AND 
TONES 

Depending on your service provider settings, Communicator notifications and tones in the 
Communications window can be hidden. 

APPLICATION OR DESKTOP SHARE 

To share your desktop or individual application: 

1. In the Communications window, click the Start Share button.  This does not yet start the
“share”.

2. Select either to share your entire display or one of your open applications and click Start
Sharing.

3. The share widget appears to let you control share settings such as Preview that shows
you what participants are seeing and Pause that pauses sharing.

4. To stop sharing, click the Stop icon.  While sharing, all other communications
mechanisms are also available, except for video calling and file transfer.

5. Participants cannot hide a share without closing the Communications window. Video call
is also available while sharing.

Desktop sharing works the same way in both My Room and the ad hoc sessions.  For 
participants without Clearspan Communicator, use the separate Desktop Share Invitation link 
available by right-clicking the My Room button. Share selector is not dynamically updated while 
the selector is open and minimized applications are not available in the list of applications to 
share. 

As a participant, you can also zoom in and out during the share.  As the share owner, incoming 
message toasters are suppressed during share, but the missed message badge is incremented 
and the incoming message sound is played when enabled. 

If you are first in a video call and then start share, your own video is not shown due to limited 
space available, but you can make it visible using the Main window menu in the bottom right-
hand corner by selecting “Show Own Video”. 

If you are using dual monitors, you can choose which monitor.  You can check the primary 
monitor in the operating system settings. 

You can also remove desktop share participants.  They are also removed from the group chat at 
the same time.  If needed, the removed participants can join later. 

Depending on your service provider settings, you may have to provide desktop share credentials 
manually. 

In addition, participants can share when enabled by the service provider by clicking on the Share 
button; however, the room owner can prevent this at any time.  Only one person can share at 
any one time in a session.  Only one share at a time is supported if you have sessions with 
many users at the same time.  Share passing is only supported in My Room. 

Participants do not have to take any action to accept share invitation.  It is automatically 
accepted.  The same also applies to share passing. That is, the owner does not have to take 
action for participant to start sharing. 



Clearspan Communicator User Guide for Desktop R22.7.1

28     |   Clearspan 

When video and share are used at the same time, the different views cannot be resized.  
Instead, the primary view can be selected from the bottom of the window via thumbnails. 

In deployments using the older web collaboration solution, clicking the Share button opens an 
external browser window where share can be viewed. 

MY ROOM 

My Room is started by clicking on the My Room icon on the left-hand side of the navigation 
pane.  My Room is started automatically using your permanent chat room.  Add more 
participants by dragging and dropping them into the Communications window or the Conference 
menu, or they can join your room by right-clicking your name on their contact list and choosing 
the Join room menu option.  Once people have joined the chat room, they can click on the Call 
button of that window to join the conference.  The room owner can also share their desktop. 

To use the full functionality of My Room (desktop sharing, conferencing, and chat combined), 
you may have to manually enter your desktop sharing credentials, your conferencing number, 
and your PIN in the Preferences → Credentials window. This depends on your service provider 
settings. 

In addition to the owner of the room, participants can also share the desktop but only the owner 
can add more participants.  This applies to both My Room and ad hoc sessions. 

1. To see a Context menu, right-click the My Room icon on the left-hand side of the
navigation pane.

2. To modify credentials and conference bridge information, select Configure to go to the
preferences.  If your service provider has automatic provisioning enabled, then this menu
item is not present.

3. Select Copy invitation to copy an invitation link to the operating system clipboard
(depending on your service provider setup, this menu option may not be available).
Paste this link, for instance, to meeting invitation e-mails to allow Clearspan
Communicator participants to join the conference in one click from, for example, Outlook
or Office applications. Note that some applications may not recognize the Communicator
link.  You can also copy the My Room invitation to the default email client (this text does
not contain the Communicator link) and go to the My Room preferences via a right-click
menu option.

The link has two parts, one for Clearspan Communicator users, and another one for users with some 

other client.  Depending on your service provider settings, the invitation can also contain a link to the 

desktop sharing session. The invitation always contains a dial-in number and PIN for users who do 

not have Clearspan Communicator.  The desktop share link, when available, allows anyone to join a 

desktop share session from a standard web browser.  In addition, the Clearspan Communicator 

group chat session is supported with the web collaboration session. For guest user links, see the next 

section. 

The My Room icon also has a tooltip indicating the conference bridge details of your My Room. You 

can also export the attendee list using the related participant menu available via the options icon 

(three dots). 

The Communications window also has an icon that provides the same Context menu previously 
discussed. 

Desktop sharing works the same way for both My Room and the ad hoc sessions. 



Clearspan Communicator User Guide for Desktop R22.7.1 

29     |   Clearspan

My Room uses your permanent chat room, permanent collaboration room, and conference 
bridge (audio or video).  My Room is the only way to use the permanent rooms.  Any other 
multiparty communications, such as selecting multiple contacts, and right-clicking for a 
conference call, or dragging and dropping for a one-to-one chat, is done using ad hoc rooms.  
Ad hoc rooms are deleted once the session is over. 

All My Room sessions start as chats but call and/or share can be added to the session while in 
progress.  File transfer and video conferencing are not supported in My Room or ad hoc 
sessions, additionally, you cannot transfer or conference My Room calls. 

You can also define that all users or only guest users need to be authorized to access My Room or 
that all users can automatically join.  My Room invitations sent by you cannot be canceled in this 
release. 

My Room and Desktop Sharing are optional Clearspan features. 

GUEST CLIENT 

Previously it was not possible to join a full My Room session with a web browser.  Guest client 
allows you to do that. 

This feature is especially intended for users outside of the company.  Generate separate 
invitations for guest users using My Room right-click menu items as described in the previous 
section.  My Room invitations are generated using separate menu items and are intended for 
Communicator users. 

Guest users can join a session with audio in the web browser by requesting a callback using the 
provided dial-in number and conference PIN as well as use group chat and sharing inside the 
web browser.  However, guest clients do not have private chat possibility and they can see the 
chat history of messages that occurred after they joined the session. 

The invitations persist until reset via a separate right-click menu item.  Individually accept each 
joining guest participant.  Not doing this in a predefined period of time results in the invitation 
becoming obsolete and guests not being able to use the link to join. 

After dismissing a guest user from share and chat, the audio/video portion can remain. 

The following OS and browser combinations are supported if Web Real-Time Communication 
(WebRTC) is disabled by your service provider: 

• Latest Chrome on Windows (Windows 7, Windows 8 [Classic], and Windows 8.1
[Classic]) and MAC OS (10.8 and 10.9)

• Internet Explorer 11 on Windows (Windows 7, Windows 8 [Classic], and Windows 8.1
[Classic])

• Safari 7 on MAC OS (10.8 and 10.9.)

The following OS and browser combinations are supported if WebRTC is enabled by your 
service provider: 

• Latest Chrome on Windows (Windows 7, Windows 8 [Classic], and Windows 8.1
[Classic]) and MAC OS (10.8, 10.9, and 10.10)

For more information on guest client usage, see Appendix B: Guest Client Usage. 
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SEARCH 

Clearspan Communicator supports a search of the enterprise directory as well as the personal 
directory, enterprise common directory, and group common.  This takes place in the same 
search field that is used for both a local and presence-enabled contact list search. The various 
directories have different purposes with the enterprise directory having the most data, and not all 
directories may be used in all deployments.  All search results are combined into one common 
set of results. 

Personal directory, enterprise common, and group common directories cannot be modified from 
the client side.  Only read access is provided.  A snapshot of the presence status of the contact 
in the results list is shown, but this presence is not updated after the search operation. 

Personal directory provides your own special contacts that are not in the enterprise directory, for 
instance, partner company’s numbers while group common contains, for example, the group’s 
contacts such as favorite pizza taxi. 

Clearspan Communicator automatically searches the local contacts and presence-enabled 
contact list in addition to the enterprise and other directories at the same time.  As soon as there 
are results from the enterprise and other directories, these results are shown on a separate list 
in the main window.  Additionally, there may be other search result groups from other search 
sources such as Lightweight Directory Access Protocol (LDAP) or Outlook. 

In a search, Communicator also supports Hiragana characters for the Japanese market. 

Search results are displayed differently depending on the results of the contact list and directory 
search: 

• If LDAP search (Corporate directory) or Outlook search are enabled, there are more
result groups.

• If there are no results for a certain search source (for example, local contacts, Outlook,
LDAP, or Clearspan telephony directory), then that group is different in the UI.

The enterprise directory searches all available fields for the search string.  By default, it waits for 
1.5 seconds before it sends the search request to the server to minimize unnecessary load on 
the server. 

Release 21.5.0 introduces support for showing phone number in the search results to better 
distinguish similar search results.  In addition, tooltips are provided for search results. 

Release 22.4.0 added support for department and title in directory search results as well as multi-part 
search string enhancements depending on service provider configuration on the server side.  The 
server will apply the AND operation for each search string part, and the order in which the individual 
parts are provided will not impact the search result.  The enhancement applies all Xsi directories 
(enterprise directory, personal directory, group common, and enterprise common).  For example: 

• While looking for Philip Moorefield, the following search string can be used:  “Phil Moore”.
An exact match of the first name is no longer required.

• Looking for Joe Gold and using “jo go” or “go jo” as a search string provides the same
results.

• If Gregory Evermoore has for instance an email address “gevermoore@company.com”,
he can be found using “ge” as a search string.

Typically when adding a contact using directory search results, there are phone numbers and 
first names in addition to last names available.  In addition, the Extensible Messaging and 
Presence Protocol (XMPP) address and other fields are imported when found to allow presence 
and chat. 
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Release 22.7.0 added support for configurability of search results for virtual subscribers such as 
call centers.  Depending on your service provider settings, the search results may look different 
in what kind of display name is shown for virtual subscribers. 

LDAP search (Corporate directory) needs to be enabled by your service provider.  In addition, 
you need to manually provide your LDAP credentials in the Preferences → Security tab.  LDAP 
search results are provided in the corporate directory group in the search results. 

Outlook integration (search and calendar integration) on Windows requires one of the following 
versions installed on the desktop: 

• Outlook 2010

• Outlook 2013

• Outlook 2016

Outlook search also works when several Outlook accounts are in use, but only one account is 
used at a time (default selected, which can be changed in Outlook).  Additionally, other related 
considerations are as follows: 

• The client searches for contacts and calendar entries in the default Outlook account.  The
account is set to the default via File → Info (left pane) → Account Settings → Account
Settings → Data Files.  Select an account and mark it as “Set as Default”.  After making
this change, sign out and sign back in to the client and it now searches that account for
contacts and calendar entries.

• The client searches the Outlook contacts only on the local machine (that is, the Outlook
Address Book).  There is no Exchange server lookup performed.  In addition, all
directories in Outlook are searched for contacts, even deleted folders.  The Contacts
directory can also have multiple levels of subfolders.

Every minute, Clearspan Communicator reads Outlook appointments.  If there is an appointment 
running at the current time, then the presence is shown as Busy – In Meeting.  Overlapping 
appointments are also handled.  Following are some examples of Clearspan Communicator 
operation with Outlook when time is 9:10 A.M. 

• There is meeting “A” 9 A.M. through 10 A.M.  Presence is shown as Busy – In Meeting.

• Presence is explicitly changed to Available at 9:15 A.M.  Presence is shown as Available.

• In the next minute, Clearspan Communicator again reads the appointments and sees that
“A” meeting is running; however, the presence was already explicitly marked as Available
and presence is not shown as Busy – In Meeting but Available.

• There is an overlapping meeting “B” 9:30 A.M. through 10:30 A.M.  Presence is shown as
Busy – In Meeting when the time is 9:30 A.M.

When deleting a meeting that is currently ongoing in Outlook, the presence status remains as 
Busy – In Meeting until the next time Outlook appointments are checked (once every minute) 
and after that, presence is shown as Available.  This change may be instantaneous, or it may 
take a minute depending on how close the timer is to being triggered. 

The Outlook Object Security model was introduced in Outlook 2007.  It has been tested with 
Outlook 2010.and Outlook 2007.  For Outlook versions prior to 2007, the Allow/Deny pop-up 
window seen in previous releases should not be triggered.  However, those versions are not 
officially supported.  For Outlook 2013, the behavior should be similar to 2007 and 2010, 
meaning the pop-up should not come up with Outlook 2007, 2010, and 2013 in Release 20.0.0 
and onwards.  However, more tests are needed for this before official support for Outlook 2013 
can be declared. 
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The presence update is only triggered by appointments and meetings that are either accepted 
by the user or made by them.  All-day meetings do not trigger a presence change to Busy – In 
Meeting. 

FULL ENTERPRISE DIRECTORY 

Clearspan Communicator allows for browsing of an entire Clearspan enterprise directory. 

To view the Clearspan enterprise directory, click the Directory button on the left-hand side of 
the navigation pane (if available).  This feature depends on the service provider configuration so 
it may not be visible in all clients. 

COMMUNICATIONS HISTORY 

The fourth icon from the top in the main window on the left side of the navigation pane displays your 
messaging history.   

History view is divided into one, two, or three tabs depending on your service provider settings.  
Possible tabs are: 

• Calls

• Chat

• Visual voice mail

Double-clicking a conversation on the chat tab list opens it in a new window while double-
clicking a call history item calls that number.  Clicking a visual voice mail downloads the 
message so you can play it. 

Clearspan Communicator saves a call history for placed, received, and missed calls.  The call 
history makes it easy for you to redial and call back when you have missed a call or you want to 
easily dial a contact with whom you have recently spoken. Each call has a separate entry in the 
list. 

Chat history for group chats, both in My Room and in instant group chat, are stored locally on the 
Desktop client, just like in one-to-one chat, but only for the time the user is joined into the session.  
Look at individual chats by double-clicking the contact in the contact list or click the chat history icon 
in the left pane. 

Double-click on a name in the list to call back directly (this calls back the same way you 
previously spoke, for example, if you were in a video call, double-clicking starts a new video 
call).  Double-clicking an incoming call item in the Calls tab makes a call. 

To clear the missed chat indicator, you must open the missed chat. 

The Communication History missed communications badges can be cleared by using the right-
click menu from the Communication History button on the left-pane.  The menu provides 
options to mark “All as viewed”, “Chats as viewed”, “Voicemails as viewed”, and “Calls as 
viewed. 

Depending on your service provider configuration, call history may also display call duration as well 
as hunt group or other Call Forwarding information. 

Release 22.5.0 added support for synchronizing the history items with configured directories so that 
the display name shown is be as accurate as possible. 
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CLICK-TO-CALL (HIGHLIGHT TEXT) 

Release 21.5.0 introduced support for Click-to-Call using highlighted text and global keyboard 
shortcuts.  Users can highlight text anywhere in the desktop machine to make a call and define the 
default call type used for making the call using the shortcut defined in Preferences.  On Mac OS, you 
must define the shortcuts on your own using the instructions provided in Preferences.  The order in 
which key combinations are pressed may be significant in some cases if the operating system has 
reserved some key combinations for other purposes. 
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CALLTO, TEL URL, AND OTHER URL SCHEMES 

You can use Communicator for making calls using Callto, and Tel URL links anywhere in your 
machine, but you need to register Communicator as the primary application for that purpose in the 
operating system.  Additionally, depending on your service provider settings, other URL schemes 
may also work. 

On Windows, at first login there is a dialog asking if you would like Communicator to be the primary 
calling application for Callto and Tel URL schemes.  Answering yes will modify Windows settings so 
that the next call using those links will use Communicator.  If another application should afterwards 
take precedence in Windows settings, you can again make Communicator the primary calling 
application from Preferences, Outgoing Calls tab. 

On Mac OS, you must make the same selection in FaceTime preferences.  You are required to log in 
to FaceTime to change the preferred calling application. 

XMPP SECURITY 

Depending on your service provider configuration, Communicator supports blocking of 
unauthorized file types in file transfer in order to support service provider IT policies.  When 
sending a file with of an unauthorized type, there is an error message showing the cause of the 
file transfer failure. 

Similarly, clickable links in chat may be disabled; however, you can still copy the link into a 
browser. 

WEB BUTTON 

As a service provider option for integrating third-party web content onto Communicator desktop, 
a left pane icon may be visible.  When clicked, it opens predefined content either in the Main 
window or on a separate web browser.  Both single and multiple links may be present. 

In addition, local applications can be used in the links, for instance, email.  This depends on your 
service provider configuration. 

Cookies are supported.  The saved cookies are stored in cookies.dat that can be accessed from 
Preferences view → General tab by clicking on the Open folder button and navigating one directory 
level up.  To remove old cookies, first exit Communicator, then remove the file and sign back in.  
Failing to exit the client results in recreating the cookies.dat with cookies from memory. Release 
22.2.0 added support for opening web content onto a tab as well. 
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OUTLOOK ADD-IN 

INTRODUCTION 

The Outlook Add-in for Communicator provides integration between Communicator Desktop and 
Microsoft Outlook and Microsoft Skype for Business (S4B). 

With this add-in, you can have Microsoft Outlook display Communicator contact presence and invoke 
Communicator functions like chat, call from computer, call from phone, and video call from within 
Outlook. 

Depending on your service provider settings, Presence is from either Communicator or S4B.  
Additionally, chat and SIP calls are done with either S4B or Communicator, depending on your 
service provider settings. 

SUPPORTED PLATFORMS 

The following platforms are supported: 

• Microsoft Outlook 2010 (32 and 64-bit), Microsoft Outlook 2013 (32 and 64-bit), and Microsoft
Outlook 2016 (32 and 64-bit).  See the following note for exceptions.

• Microsoft Windows 7 SP1, Microsoft Windows 8, Microsoft Windows 8.1, and Microsoft Windows
10

• Communicator Release 20.2.0.x or higher officially supported version.

Note: The current version of this add-in cannot be used if you have 
Microsoft Office Communicator or Skype installed.  You must uninstall 
these products if you want to use this  
add-in.  Skype for Business can be used at the same time. 

Outlook 2010 cannot be used together with the S4B integration feature 
introduced in Release 22.3.0 for newer Outlook versions.  Additionally, 
administrator rights are required for the Outlook Add-in except for Outlook 
2010. 

The following language and locale combinations are supported in the installer and the add-in: 

• Chinese (Simplified)

• English

• French

• French (Canada)

• German

• Italian

• Japanese

• Korean
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• Spanish

• Spanish (CALA)

• Portuguese (European)

• Dutch

The following third-party components must be installed for the add-in to function correctly: 

• Microsoft .NET Framework 4 Client Profile

• Microsoft Visual Studio Tools for Office (VSTO) 2010 Runtime

These components are downloaded and installed by the installer if they are not found.  They should 
not be uninstalled, as the add-in cannot functional correctly.  Additionally, for Outlook 2016 and the 
Outlook Add-in (OL2016 Add-in), there are further considerations as follows: 

• The Outlook Add-in can only be installed by an administrator.

• If an administrator installs for all users and a normal user starts using the OL2016 Add-in,
Communicator must start before Outlook.

• For logging to work normally, Communicator must start before Outlook.

• Every logging level change requires a restart of both Communicator and Outlook for changes
to take effect.  This should be quite rarely needed.

• If Outlook is closed while Communicator is running, Communicator must be restarted as well
for the Outlook UI to behave as expected.

• Communicator lists connected components as extensions, if connected is NO or if
component version number is something other than 10.2.1.29, or both presence GW and
add-in are not listed, an error has occurred.  Component is visible under Options → Add-ins
→ UI, which displays registered and working add-ins on top, below stopped or non-working
ones.

• If both are listed and show connected is YES, but the Outlook UI does not work, restart both
apps.

• For Outlook upgrade requirements, see section Installation.

• For Outlook 2010, all contacts must be updated to have a SIP address.  For Outlook
2013/2016, the following applies:

1. The SIP address does not need to be entered for the contacts, as long as there is an
email address that matches the Outlook contact.  The same value is looked for in the SIP
address field, but it is probably more practical to have it in the email address.

2. The Outlook Add-in allows you to choose which number to call.

3. Two Outlook or Communicator contacts cannot have the same email address or IM
address, otherwise full functionality cannot be guaranteed.

Note:  Communicator must be installed with administrator privileges in 
C:\Program Files OR the C:\Program Files (x86) folder. 



Clearspan Communicator User Guide for Desktop R22.7.1 

37     |   Clearspan

LOG FILES 

Log files for the Add-in are located in the Communicator log directory.  You can open the folder 
via Preferences → Advanced by clicking on the Show logs button.  Outlook Add-in logging is 
turned on when Communicator logging is enabled. 

WINDOWS REGISTRY ENTRIES 

The following table lists all the registry entries added or modified by the installer. 

PATH KEY COMMENT 

HKEY_CURRENT_USER\Software\BroadSof
t\Communicator\OutlookPlugin\olwnd 

wnd Keeps Outlook applications window reference. 

HKEY_CURRENT_USER\Software\BroadSof
t\OutlookPlugin 

LoggingLevel Logging level for Outlook plugin components.  
Its value as per Communicator Options → 
Advanced logging selection as follows: 

Basic logging on:  0x00000003 

Detailed logging on:  0x00000005 

Both off:  0x00000000 

HKEY_CURRENT_USER\Software\BroadSof
t\InstalledBrandedBTBC 

Can also exist in HKEY_LOCAL_MACHINE 
(even under Wow6432Node). 

Example, 
OutlookPluginPath, 
CompanyName, 
ProductName 

These keys affect where the plugin is 
searched for when starting and where log 
files are written. 

HKEY_LOCAL_MACHINE\Software\Microsoft
\Office\Outlook\Addins\Communicator Add-in 
for Outlook 

LoadBehavior 0x00000003, based on this value Outlook 
loads the add-in dll. 

HKEY_LOCAL_MACHINE\Software\Microsoft
\Office\Outlook\Addins\Communicator Add-in 
for Outlook 

Description Communicator Add-in for Outlook. 

HKEY_LOCAL_MACHINE\Software\Microsoft
\Office\Outlook\Addins\Communicator Add-in 
for Outlook 

FriendlyName Communicator Add-in. 

HKEY_LOCAL_MACHINE\Software\Microsoft
\Office\Outlook\Addins\Communicator Add-in 
for Outlook 

Manifest $INSTDIR\plugins\Outlook$nOutlookBitness\
UC-Outlook-addin.vsto|vstolocal 

HKEY_CURRENT_USER\Software\IM 
Providers 

DefaultIMApp Communicator 

HKEY_CURRENT_USER\Software\IM 
Providers\Communicator 

UpAndRunning 0x00000002 

HKEY_LOCAL_MACHINE\SOFTWARE\IM 
Providers\Communicator 

FriendlyName BroadsoftIMApp 

HKEY_LOCAL_MACHINE\SOFTWARE\IM 
Providers\Communicator 

GUID {E3D1613A-93B2-4237-B4B8-
B50595462C25} 

HKEY_LOCAL_MACHINE\SOFTWARE\IM 
Providers\Communicator 

ProcessName presencegw.exe 
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HKCU\Software\IM 
Providers\DefaultI
MApp 

Clearspan Mobile/Tablet Application name Needs to be 
taken by 
Communicator 
to be able to 
call, for 
example, call 
PSTN 
numbers from 
Outlook. 

INSTALLATION 

The Outlook Add-in installation is integrated with the Communicator installation.  There is a check box 
in the installer to enable the Outlook Add-in installation.  If Outlook is upgraded, the Outlook Add-in 
must be re-installed, since the Add-in uses different files depending on the Outlook version. 

The Outlook Add-in installation requires administrator rights to the computer for all Outlook versions. 



Clearspan Communicator User Guide for Desktop R22.7.1 

39     |   Clearspan

FEATURES 

Presence in Outlook 

The Outlook Add-in displays the presence of a contact in Outlook.  Presence information is retrieved 
from Communicator and is displayed as an icon next to the contact in emails and calendar 
appointments.  The following is an example of an email with the To, From, and Cc fields showing 
presence for various contacts. 

Figure 1  Presence Displayed in Outlook 

A contact’s presence can be Available, Away, Busy, or Offline as shown in the following figure. 

Figure 2  Presence Values 

Note: You must be signed in to Communicator for the presence to be 
displayed.  Additionally, presence is only shown for contacts that have a 
valid SIP address and are in your contacts list in Communicator. 
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Contact Actions in Outlook 

Right-click on an email in your Inbox and call or chat with the sender using Communicator.  You have 
the option to Chat, Call (from Computer), Call from Phone, or Video Call as shown in the following 
figure. 

Figure 3  Contact Options 

Note: Some of these options may not be available for all contacts.  The chat 
option is only applicable to contacts that are in Communicator.  Call options 
are applicable to all contacts as long as they have a valid phone number. 
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These contact actions are also available on a contact card as shown in the following figure. 

Figure 4  Contact Card 

Call Multiple Phone Numbers Configured for Communicator / Non-Communicator 
Contacts 

You can call any of the multiple phone numbers present in the Outlook contact card.  This feature is 
available from received mail context menu, flagged mail context menu, and Contact’s context menu. 
You can also call the selected phone number via Call, Call from Phone, and Video Call. 

However, you cannot call multiple numbers for contacts stored on the Clearspan Mobile/Tablet client 
or contacts in LDAP (AD) directories; only numbers stored in Outlook. 
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See the following figure for an example of how to make the call from a received mail context menu. 

Figure 5  Received Mail Context Menu in Outlook 

See the following figure for an example of how to make the call from the contact item context menu. 

Figure 6  Contact Item Context Menu in Outlook 

UNINSTALL OUTLOOK ADD-IN FOR COMMUNICATOR 

Uninstallation is done together with uninstallation of Communicator. 
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END-USER CONFIGURATION 

SIP Address in Microsoft Outlook Contacts 

Note: This section is only applicable if you use Microsoft Exchange with 
Outlook.  You do not need to configure the SIP address for SMTP-based 
accounts (for example, Google Mail). 

In order for the Outlook Add-in to integrate with Communicator, you must set a SIP address for each 
contact.  The SIP address for a contact in Outlook must match the SIP URI, Instant Messaging and 
Presence (IM&P) address, or Email field in Communicator.  This is usually done by your Microsoft 
Exchange or Active Directory administrator. 

You can check if a SIP address has been configured for contacts by looking at the Outlook properties 
for a contact.  In Outlook 2010, open a contact card and then click on the View more options button 
as shown in the following figure. 
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Figure 7  Outlook Contact Properties 

Then select the Email Addresses tab.  It should have a SIP address in the list of Email Addresses as 
shown in the following figure. 

Figure 8  SIP Address for Outlook Contact 
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If the SIP address is missing, you can try to update the Address Book from the server as shown in the 
following figure. 

Figure 9  Download Address Book 

Additionally, when adding contacts from Outlook to Communicator, the IM address field can be 
populated in Outlook so that the presence feature can work directly on the Communicator side as the 
information is imported to the Communicator contact card. 

COMMUNICATOR ADD-IN FOR MICROSOFT SKYPE 
FOR BUSINESS 

Communicator for Desktop supports integrating with Microsoft Skype for Business (S4B).  The 
primary intended use case is using Communicator for non-S4B calls such as calls to mobile, 
while presence, chat, and S4B-to-S4B calls still take place via S4B. 

Existing S4B integration with, for example, SharePoint, Office 365, and Internet Explorer can be 
used so that calls can be made from those applications. Usual Communicator call control 
features such as hang up, mute, transfer, conference, and Call Park are supported.  
Communicator call logs and call settings are also available in this configuration. 

Communicator also updates phone presence on the S4B side. 

Communicator must be started after S4B for calling to work smoothly. 

For detailed calling examples, see Appendix C: Skype for Business Integration. 

FORCED CONFIGURATION UPDATE 

Depending on your service provider configuration, forced configuration update can be supported.  
When enabled, you will be prompted to log in again when the configuration has changed.  This will 
not happen however if you have ongoing calls, share, or group chat sessions. 
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PASSWORD CHANGE 

A dialog box automatically opens when your login password must be changed.  You must provide the 
password two times for verification purposes.  Using a menu in either the bottom right-hand corner or 
the top of the Main window, your password can be changed at any time. 

PRIVACY POLICY 

If you want to read the service provider privacy policy that can be done by clicking the privacy policy 
link available in the About view when enabled by your service provider.  If you service provider has 
not enabled the link, it will not be present in the About view. 

ACCESSIBILITY COMPLIANCE 

Communicator supports accessibility compliance starting in this release by having all client features 
available in menus at the top of the Main window.  The menu items are also available using the 
keyboard shortcuts listed in Appendix A: Keyboard Shortcuts for Desktop. Release 21.6.0 added 
support for the following features: 

Dictation 

Screen reader (VoiceOver on Mac OS) 

Keyboard navigation 

The following limitations apply: 

On Mac OS by default, the tab key moves the focus between text-inputs and lists.  This can be 
changed through System Preferences → Keyboard → Shortcuts.  Under Full Keyboard Access, 
select “All Controls” instead of “Text boxes and lists only”. 

Dictation on Mac OS:  If WebRoot SecureAnywhere is used, Pause Secure Keyboard Entry must be 
selected. 

Users must manually select the correct language in screen reader.  Clearspan Mobile/Tablet does not 
force screen reader's language according to the language selection in the client. 

On Mac OS, the VoiceOver focus follows the VoiceOver Cursor.  When VoiceOver is enabled, users 
are expected to navigate with the VoiceOver Cursor.  That can be enabled through System 
Preferences → Accessibility → VoiceOver → Open VoiceOver Utility.  In the opened window, open 
“Navigation” and check “Keyboard focus follows VoiceOver cursor”. 

When using VoiceOver on Mac OS with different languages, the OS language, client language, and 
VoiceOver language must all be the same. 

Recommended Preferences → General → Accessibility settings for screen reader/VoiceOver are: 

ToolTips disabled 

Pop-up errors enabled 
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GOOGLE ANALYTICS 

Clearspan Mobile/Tablet Communicator can send analytics data to your service provider and/or 
Clearspan to improve the service.  You can enable and disable this option in Preferences. 

FEDERAL INFORMATION PROCESSING 
STANDARD COMPLIANCY 

Communicator can also be deployed in Federal Information Processing Standard (FIPS) compliant 
mode if enabled by your service provider.  In this mode, all encryption is done in a FIPS-compliant 
way.  All functionality except the following is available: 

Banner 

Web button 

PERSONAL IDENTITY VERIFICATION SUPPORT 

Communicator Desktop supports Personal Identity Verification (PIV) on Windows only.  If you have a 
PIV card and the associated card reader is attached to your PC, you can log in to Communicator by 
only providing a PIN related to your PIV card. 

It is possible to first use Communicator in non-PIV mode and later in PIV mode if your service 
provider has enabled this. 

Other Communicator functionality is not impacted. 

FEDERAL INFORMATION PROCESSING 
STANDARD COMPLIANCY 

Communicator can also be deployed in Federal Information Processing Standard (FIPS) compliant 
mode if enabled by your service provider.  In this mode, all encryption is done in a FIPS-compliant 
way.  All functionality except the following is available: 

• Banner

• Web button

PREFERENCES 

Preferences provide access to available settings for Communicator.  Follow these steps to access 
Preferences. 
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Windows and Mac OS 

1 Click the Preferences logo in the Main window left pane. 

2 Select the desired view from the drop-down. 

or 

Windows and Mac OS 

1 Go to the Communicator accessibility menu. 

2 Select Preferences. 

3 Select the desired view from the drop-down. 

GENERAL 

Language 

Select your language and then click OK or Apply and the change takes effect immediately.  Note 
that the number of languages depends on your service provider. 

Login 

Enable or disable automatic login when starting the application and control the remember 
password feature as well as enable the Update Password feature. 

Notifications 

Usually there is a confirmation pop-up notification each time you remove a contact or chat history 
record.  By selecting one or all of the check boxes, you can disable the confirmations when deleting 
information.  Here you can also control whether there is always a pop-up notification for publishing 
location information.  Typically, this is shown at login. 

You can also select whether to receive a notification before ending communication or holding a call. 

Accessibility 

Enable pop-up errors allows Communicator error pop-ups to be shown in addition to the usual error 
text shown at the top of the Main window. 

Enable ToolTips is enabled by default.  For accessibility, screen reader/VoiceOver reads all ToolTips, 
which may be frequent and hence disturbing.  For this reason in accessibility cases, it is 
recommended to disable ToolTips. 

You can also enable spell checking and auto-capitalization. 
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MEDIA 

Audio 

Output Device (Voice Playback) 

Choose a headset, PC-integrated speakers, or external speakers for audio output.  Your external 
playback device is selected by default (if you have one connected). 

Output Device (Voice Playback) 

Choose a headset, PC-integrated speakers, or external speakers for audio output.  Your external 
playback device is selected by default (if you have one connected). 

Speakers 

Here you can specify what are the output and input devices used for speakers when toggling between 
the headset and speakers.  Note that to be able to toggle between the headset and speakers during 
calls, you must specify a different device for each.  Using the default for both results in the same 
device being assigned to both so toggling does not work. 

Output Device (Voice Playback) 

Choose a headset, PC-integrated speakers, or external speakers for audio output.  Your external 
playback device is selected by default (if you have one connected). 

Input Device (Voice Recording) 

Choose a headset microphone, PC-integrated microphone, or external microphone for voice during 
calls.  Your external recording device is selected by default (if you have one connected).  You can 
also choose automatic gain control and test your recording device. 

Microphone 

Ring Device (Alert Signal) 

Select the audio device that is played when you receive an incoming call.  

Ring Signal 

You can select your own ring signal.  The same signal is used for both voice and video calls.  You 
can also select an icon to play a tone for incoming messages.  To disable the tone, uncheck the icon.  
Select a sound event and then click Play to hear the sound. 

Video 

Capture Device (Video) 

Select a camera that you want to use for video calls.  Your external web cam is selected by default (if 
you have one connected). 
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Video Size 

Select one of the available sizes.  Note, however, that higher sizes require more bandwidth and a 
more capable central processing unit (CPU). 

CLICK TEST CALL TO MAKE A TEST CALL TO TEST VOICE 
QUALITY. INCOMING CALLS 

For the list of available call management services for incoming calls, see section  
Call Settings.  If Alert Info service is used, the network may instruct a certain ringing tone to be 
played. 

OUTGOING CALLS 

For the list of available call management services for outgoing calls, see section  
Error! Reference source not found..  Release 22.7.0 introduced support for the Review feature that 
you can enable in Preferences → Outgoing calls.  Review brings you to the dial pad with the called 
number pre-populated so that you can modify or review it when you are using the default call type by 
for instance double-clicking a call history item.  In addition, highlight to call and Register to call 
settings are available in Outgoing calls. 

VOICE MAIL 

You can specify various voice mail settings, such as which calls are sent to voice mail, what kinds of 
notifications you receive when voice mail arrives as well as controlling how fast the voice mail 
greeting is played and if callers are allowed to leave voice mails.  In addition, you can control how 
callers can end up going to voice mail. 

SERVICES 

In this release, this section is reserved for presence rules.  For more information on presence rules, 
see section Presence Rules and Silent Alerting. 

EXTENSIONS 

Select how incoming add-in requests are handled, whether they are automatically accepted or not or 
if incoming requests are allowed at all.  

Depending on your service provider configuration, you can also manage extensions using the 
Communicator Application Programming Interface (API), which is used by third-party applications 
such as the Outlook Add-in or compatible headsets.  You can allow such third-party applications to 
obtain information from Communicator and enable or disable confirmation pop-up notifications when 
third-party applications request information from Communicator.  You can also choose default 
behavior to always reject or accept requests from third-party applications and allow or reject individual 
third-party applications. 

Starting with Release 22.0.0, the following logic applies for accepting application requests: 

Every new first-party application is allowed to connect without user interaction. 

Every new third-party application opens a dialog asking for permission to connect.  Your response is 
remembered (both negative and positive responses). 
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ADVANCED 

The Advanced view contains three different subsections: 

• Logging

• Proxy

• Credentials

TROUBLESHOOTING 

Logging is used for troubleshooting.  You may be asked by your service provider to turn on logging 
and then send a log file directory contents.  You can choose basic logging or more detailed logging to 
be enabled.  Detailed logging may consume memory resources so it is not recommended to have it 
enabled for a long period of time. 

You can also clear the logs and open the logging folder as well as enable and disable Google 
Analytics. 

Logging 

Logging is used for troubleshooting.  You may be asked by your service provider to turn on logging 
and then send a log file directory contents.  You can choose basic logging or more detailed logging to 
be enabled.  Detailed logging may consume memory resources so it is not recommended to have it 
enabled for a long period of time. You can also clear the logs and open the logging folder. 

Proxy 

Select how to handle HTTP proxies.  By default, the system settings are used but you can also 
choose not to use an HTTP proxy or to use Clearspan Communicator (client) proxy settings. 

Credentials 

Configuration URL 

If the Device Management configuration URL is available to be viewed, it appears here. 

IM Address 

If XMPP credentials are available to be viewed, they appear here. 

Clearspan ID 

This is the username you use to log in. 

CALL SETTINGS 

Clearspan Communicator supports the following service management features allowing 
supplementary services to be managed using the Preferences and Call Settings view available in the 
Main window left pane by selecting the appropriate sub-view in the drop down: 
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• Incoming calls

• Clearspan Anywhere

• Clearspan Remote Office

• Forward Calls

• Do Not Disturb

• Simultaneous Ring Personal

• Anonymous Call Rejection

• Call Waiting

• Voice Messaging

• Outgoing Calls

• Block My Number (Calling Line Identification Presentation [CLIP]/Calling Line
Identification Restriction [CLIR])

• Automatic Callback

• Highlight to call

• Register to call

You can also use the call settings with a Main Window toolbar on the top of the window, if this 
feature is enabled.  When enabled, this feature allows Clearspan Anywhere, Do Not Disturb, 
Remote Office, and Call Forwarding to be managed in the Main Window using single clicks or 
right clicks. From Release 20.2 onwards, the Call Settings toolbar is an icon in the left pane 
with right-click menus. 

CLEARSPAN ANYWHERE 

Clearspan Anywhere allows service providers to offer fixed-mobile convergence (FMC) services 
today without additional equipment. 

Clearspan Anywhere simplifies communications for on-the-go users and remote users by 
extending the features of a desk phone to any other fixed or mobile device, regardless of the 
network or handset manufacturer.  Callers dial one number and can reach you on any phone the 
user chooses.  A desk phone, cell phone, and/or a soft phone may ring simultaneously. 

Experience voice call continuity with the ability to move live calls from one device to another 
without hanging up. 

Add locations (numbers) that can be used in the service via the Add Number field.  Use the 
Alert all locations simultaneously check box to activate parallel ringing. Click on the “+” icon to 
see more options. 

The Don’t divert check box prevents a call from ending up as a voice mail, which can be 
problematic in, for example, conference call situations. 

Select Answer Confirmation to receive a separate audio prompt when answering a call from that 
number (location).  It may be useful in cases where, for example, mobile numbers are being 
used to prevent incoming calls going to mobile voice mail since the call will be ended without 
going to voice mail if the answer confirmation is not provided. 

Select the Call Control check box to enable the server platform to provide mid-call services such 
as Call Transfer and Conferencing for that number (location). 

Clearspan Anywhere is a premium feature. 

|   Clearspan
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CLEARSPAN REMOTE OFFICE 

This service allows the use of any phone as the office phone from a charging and numbering 
perspective.  For instance, a hotel room phone can be used as the office phone. 

Enable Remote Office by clicking the service icon and specifying a phone number to be used as 
the Remote Office number. 

Clearspan Remote Office is a premium feature. 

FORWARD CALLS 

Enter a number to which your calls should be forwarded.  Different variants of call forwarding are 
supported, such as forwarding always, forwarding when busy, and forwarding when you cannot 
answer or when you are unreachable. In addition, you can specify the number of rings before 
call forwarding is triggered. 

DO NOT DISTURB 

When you activate this service, all calls are typically blocked by the server and sent to voice 
mail.  Enable this service by enabling the service icon. 

HIDE NUMBER 

You can hide or display your number when calling or communicating with other parties or 
contacts.  Hide your number by enabling the service icon.  To show your number, set this to 
Disable. 

SIMULTANEOUS RING PERSONAL 

Add up to 10 additional numbers or Session Initiation Protocol Uniform Resource Identifier (SIP-
URI) addresses that you would like to ring in addition to your primary number when you receive 
a call.  In addition, specify whether you want answer confirmations and if you would like to 
receive calls when already on another call.  This service is an older variant of Clearspan 
Anywhere. 

VOICE MESSAGING 

You can enable or disable voice messaging in the Preferences and Incoming Calls tab.  A 
number of settings are available: 

• Send all calls to voice mail.

• Send busy calls to voice mail.

• Send unanswered calls to voice mail.

• Specify how voice mail messages are handled using an indicator in Communicator or
forwarding to e-mail.

• Enable notifications of new messages via e-mail.

• E-mail a carbon copy of new voice mail.

• Transfer incoming calls to a specified number using “0” DTMF.
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• Specify how many rings are used before sending an incoming call to voice mail.

• Allow/disallow callers to leave a message.

ANONYMOUS CALL REJECTION 

The Anonymous Call Rejection service allows you to reject calls from parties who have explicitly 
restricted their identities. You can enable or disable anonymous call rejection in the Preferences 
and Incoming Calls tab. 

AUTOMATIC CALLBACK 

The Automatic Callback (ACB) service allows you to be notified when the previously called busy 
party becomes idle and is connected without having to redial the phone number. 

When you call another party and the call cannot be connected because the line is busy, you are 
prompted to make an automatic callback request (for example, “The line you are calling is busy. 
Press 1 if you would like to be notified when the line becomes available”). 

If you select Automatic Callback, the system monitors the busy party and automatically 
establishes a call when the busy party becomes available. 

You can enable or disable Automatic Callback in the Preferences and Incoming Calls tab. 

CALL WAITING 

The Call Waiting service allows you to answer a call while already engaged in another call. 

You can enable or disable server-based call waiting in the Preferences and Incoming Calls tab. 
If you disable Call Waiting, the second incoming call will not be connected and the caller hears 
an announcement that the call cannot be completed. 

SIGN OUT 

Signing out of Clearspan Communicator sets your status to “Offline” for your contacts and 
displays the Sign In screen. 

SIGN OUT OF CLEARSPAN COMMUNICATOR 

To sign out, follow these steps. 

Windows 

1. Click the Clearspan Communicator logo in the main window title bar.

2. Select Sign Out.

MAC OS 

1. Select Actions from the main menu.

2. Select Sign Out.
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EXIT APPLICATION 

To exit the application completely, follow these steps. 

Windows and MAC OS 

Close the Sign In window. 

Windows 

1. Select the Clearspan Communicator logo in the main window title bar.

2. Click Exit (a keyboard shortcut can also be used).

MAC OS 

1. Select Clearspan Communicator from the main menu.

2. Select Quit Clearspan Communicator (a keyboard shortcut can also be used).

 Note: Closing the main window (not the Sign In window) does not exit the 
application but rather minimizes the application to the system tray (Dock).  This 
allows you to continue to receive calls and messages without having the Contact 
List window appearing on the desktop. 
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MULTI-DEVICE SUPPORT 

Clearspan Communicator supports users with multiple devices, according to the XMPP 
specifications.  This is comprised of several features: 

• Chat invitations sent to a user are received on all devices.  Once a particular device has
been used to answer the chat invitation, subsequent incoming messages only go to that
device.

• One can retrieve one’s own presence notifications when another client updates the user’s
presence.  The client stores this information and updates its own presence so that it is
the same as the higher priority status it received, (that is, when the received status
update is manual).  If the received presence update is not manual, it does not react to the
received update; it only notes it.

• Accepting a sharing presence invitation in one client is also recognized by another client,
and both clients start receiving presence updates.

• Last sent and received messages are available on all devices when the optional
message history feature is in use.  All devices should use that feature at the same time to
avoid duplicate messages.

• A new presence subscription made in one client is recognized in another.  If the contact
blocks the “invitation”, there are presence notifications from the server to all of the user’s
clients that indicate that the subscription was terminated and this information is shown to
the user.  If the client receives two presence authorization requests from two or more
devices for the same user, it only shows one request to the user.

• Removing a contact from the contact list in one device is recognized in another client and
the contact list is updated (that is, the contact is removed) in the other client as well.

If a user has many devices, each device has the same status when shown to the end user.  In 
addition, the contacts on the contact list always see the same status with updates shown in the 
following priority order: 

• Busy

• Online

• Away

• Offline

This means, for example, that if one client publishes a Busy status and another client publishes 
another status, contacts see the user as Busy.  Compatible devices such as desk phones are able to 
show presence in the same way. Communicator keeps track of its own presence status as well as the 
status of other devices and deducts the combined presence based on these.   

When Connect and Communicator Desktop are used together, the automated presence feature is 
recommended to be used to have presence shown fully in both clients as Connect does not use 
XMPP. 

When Connect and Communicator Desktop are used together, there are also some rules about 
location.  Mobile applications have a concept of background and foreground mode to save device 
resources.  When Connect comes to the foreground, it updates its location. 
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The Desktop client does not have separate state for being on foreground; it only detects general 
usage of the device.  The client can be on the background or foreground and based on idle detection 
it can drop to away.  This requires that the computer is not used at all; moving the mouse/using 
keyboard triggers resuming to available again and it also resets the idle timer.  Today, idle detection 
(or returning from idle) does not trigger location update on Desktop in this release. 

When both clients are set to automatic, the last one to publish location “wins”.  As mentioned, 
Connect updates the location in automatic mode when coming to the foreground while Desktop does 
not have a similar concept.  In addition, the last location update, initiated by you, manual or 
automatic, “wins”. 
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INSTALLATION 

Installer supports a number of options on Windows: 

• Agree to the license agreement.

• Run when system starts (can be changed later in Preferences window).

• Install Outlook Add-in.

• Install S4B integration

• Modify Windows registry to enable S4B dial pad.

• Create a desktop icon.

• Select destination folder for installation.

• Select the name of the software in the Program menu.

• Launch the client after installation.

When installer has been run on an end user’s behalf by an administrator, the “Run program when 
system starts” option cannot be changed that end user. If you disable startup, for example, in the 
Task Manager's Startup list (on Windows 8 and 10) or from msconfig.exe on Windows 7, the change 
is not reflected in Preferences.  The checkbox remains checked and grey even though the client is 
not actually started automatically when the system starts. 

When Communicator is installed for the first time, you can choose the language if many languages 
are supported in the installer.  The default language is the language of the operating system; if that 
cannot be found, English is used as the fallback. 

Starting with Release 21.5.0 and depending on your service provider settings, the Outlook Add-in 
installer is bundled together with the Communicator installer. 

History is specific to the application name.  If upgrading to another Communicator version that has a 
different application name, the history present in the other version is not available. 

Starting with Release 22.3.0, both the Outlook Add-in and S4B integration can be used 
simultaneously. 
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UNINSTALLATION 

The uninstallation procedure is different for Windows and MAC OS. 

Windows 

Uninstallation is performed by launching the Windows uninstaller via the Start menu or by using 
the Windows “Remove programs” view inside the Control Panel.  Windows uninstallation does 
not require you to select any options. All files are deleted at uninstallation, except for the 
following files: 

• Registry entries

• Account files are only deleted when explicitly allowed by the end user on Windows.

MAC OS 

Uninstalling is performed by simply dragging the application folder from the Applications directory to 
the trash can; however, account files are not deleted.  If you want to remove account files, they must 
be manually deleted. These are the file locations for the account directories.  The following locations 
apply for all account directories: 

For branded clients: 

/Users/<USERNAME>/Library/Application 
Support/<company_name>/<application_name> 

For the reference client: 

/Users/<USERNAME>/Library/Application Support/BroadSoft/Communicator 
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VERSION CONTROL AND AUTOMATIC UPGRADE 

Depending on your service provider settings, you may receive a notification to upgrade 
Communicator to a newer version.  Starting with Release 22.3.0, this upgrade may take place 
automatically after you accept it in a separate dialog.  In older versions, you must manually install the 
downloaded upgraded version. 

The upgrade may be recommended or mandatory.  If it is mandatory, then Communicator does not 
start before the upgrade is done. 

In automatic upgrade dialog you can choose between: 

• Remind Me Later – You’ll get a new pop-up at next login.

• Skip This Version – You won’t get a new pop-up for this version, but the next or if you
manually check for updates in the menu.

• Update Now – upgrade is done immediately.

If you do not have administrator rights on your computer, the automatic upgrade typically does not 
work (your service provider may have hidden automatic upgrade UI elements for this reason).  An 
exception is when a login attempt fails because the mandatory upgrade is missing. 

In general, there are two cases when automatic upgrade popups are shown to you when you do not 
have administrator rights: 

If the update is mandatory. 

OR 

If you installed Communicator without an Outlook or S4B Add-in and you also have access rights 
to write in the installation directory. 
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SYSTEM REQUIREMENTS 

System requirements are as follows: 

• Operating system:  Mac OS 10.11 El Capitan, Mac OS 10.12 Sierra, Mac OS 10.13 High
Sierra, Mac OS 10.14 Mojave, Windows 7 SP1, Windows 8/8.1, or Windows 10 (Classical
view only).

• The installation footprint is approximately 125 megabytes (MB) on Mac OS and 215 MB on
Windows.

• For voice calls, a sound card, speakers, and a microphone or a headset are required.

• For video calls, a web cam is required.

o Minimum system requirements for respective operating systems need to be fulfilled,
with the following additions:

• A minimum of 2 GB random access memory (RAM) is required.

• A minimum 1.5 GHz CPU is recommended.  A dual core CPU is recommended for video calls
at a minimum.

• Open Graphics Library (OpenGL) 1.5 or higher is recommended.

o For high definition (HD) video, the following is recommended:

• HD camera

• HD resolution support in display

• Quad Core x86 or equivalent at a minimum

• GB RAM

VDI environments are not supported. 



Clearspan Communicator User Guide for Desktop R22.7.1

62     |   Clearspan 

TROUBLESHOOTING 

Why are my Emojis showing as black boxes? 

The Segoe UI font is required for the Emojis to appear correctly.  For more information to install the 
Segoe UI font, see the following article: 

https://support.microsoft.com/en-us/help/4021341/emojis-are-not-displayed-in-office-applications-in-
windows-7 

Why did I lose chat history after an upgrade to a renamed Communicator? 

When installing a Communicator version that has a different application name, the history is specific 
to that application name.  If the application name remains the same in the upgrade, the previous 
history is available. 

Why can’t I chat with contacts from Yahoo? 

Chatting with users in other domains is possible, but depends on the domain.  For instance, 
BroadCloud supports Google federation but not Yahoo.  However, group chat is not supported in 
Google federation, so the group chat option with those contacts is shown in grey. 

Why can’t I change the avatar? 

Double-clicking the avatar should open a File Explorer view to select a file.  If your XMPP connection 
is lost, changing the avatar does not succeed.  A lost XMPP connection is indicated in the Main 
window’s top notification area. 

My contacts are all offline and my client’s status bar says “XMPP unavailable”.  What does this 
mean? 

It means that the XMPP connectivity has been lost for chat, as well as for presence; however, you 
can still make calls.  You should contact your service provider. 

Why am I offline? 

If you have selected “Offline” status, you are shown as offline to others.  Another possibility is that you 
may have lost your Internet connection.  In this case, the client does not log out, but rather enters an 
offline mode where a contact list is available but communication is not possible. 

Why can’t I have more video resolutions available? 

You can choose your video resolution from Preferences and the Video tab.  Your selection is used by 
default for future video calls.  The available resolutions are automatically presented based on your 
camera. 

https://support.microsoft.com/en-us/help/4021341/emojis-are-not-displayed-in-office-applications-in-windows-7
https://support.microsoft.com/en-us/help/4021341/emojis-are-not-displayed-in-office-applications-in-windows-7
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Why can’t I change my user name and password? 

User name and password editing is not supported in the client.  To edit your user name or password, 
contact your service provider.  The exception is login password expiry.  When it expires, you can 
change the password in a separate dialog window. 

In Preferences, the client only supports changing credentials when enabled by the service provider. 
Desktop sharing credentials may also be changed, depending on your service provider settings. 

Why does my all day calendar entry not trigger Busy – In Meeting presence status? 

Not all meetings trigger a presence change to Busy – In Meeting. 

To trigger the presence update, the meeting must be in the Show me as busy state. 

Why aren’t all my group chat messages saved? 

Only the newest chat room messages are stored on the server, but never for My Room for security 
reasons.  Starting from Release 21.3.0, when the optional (Preview mode in Release 21.3.0 and fully 
supported in Release 21.4.0) message history feature is enabled by your service provider, messages 
sent from other devices are also shown. 

Why aren’t all my chat messages available in my other devices? 

All one-on-one and group chat messages are saved, but only locally, so they are not necessarily 
available in your other devices.  Incoming messages are sent to all devices; however, the ones that 
you send are only stored in the device that you are using to send the message.  Starting from 
Release 21.3.0, when the optional (Preview mode in Release 21.3.0) message history feature is 
enabled by your service provider, messages sent from other devices are also shown. 

Why can’t I change the XMPP address of a contact? 

This is not supported in this release.  However, you can delete the contact and add a new one. 

Why does my location show an incorrect address? 

It is done based on the public IP address that the machine is using.  The IP address is mapped to a 
physical location.  Clearspan is working with the mapping provider to improve the accuracy of the 
location.  You can also manually change the location by clicking the avatar and changing the location 
icon. 

Why can’t I start desktop sharing? 

To share your desktop, you need to have valid credentials, either by manually entering desktop 
sharing credentials in the Preferences → Credentials window, or by using auto-provisioning to enable 
the desktop sharing menu items and icons.  However, you can participate in desktop sharing 
sessions even without any sharing credentials.  Your service provider settings dictate if auto-
provisioning is enabled or not. 
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Why can’t My Room participants share the desktop? 

Only the owner of the room can share the desktop before Release 21.2.0.  Starting in Release 21.2.0, 
participants can also share when enabled by the service provider.  This applies to both My Room and 
ad hoc sessions. 

I have a USB headset and the Call Control features are not working.  Is there anything special I need 
to do to enable Call Control support? 

In order to use headsets on Windows (not supported on Mac OS), several steps are needed: 

• When the client is started, you must accept the API connection request from the
connector/add-in device.

• Additionally, your client must have the feature enabled by your service provider.

• If your USB headset uses its own add-in, the standard HID Add-in from Clearspan must be
disabled, as both cannot be used at the same time.  In addition, you must have “Allow 3rd

party extensions” check box checked in Preferences → Extensions tab.

• After upgrading Clearspan Mobile/Tablet, some USB headset add-ins may get deleted
causing call control to not work and the add-in to not be visible in Preferences.  As a
workaround, repairing/re-installing the add-in software corrects this.

Why is the Outlook Add-in disabled? 

If the context menu does not show Add-in menu items, this could be due to the Outlook Add-in 
disabled by Outlook for slow loading.  This happens primarily in Outlook 2013.  In such cases, enable 
this add-in by selecting the Outlook menu → File → Info → Manage Add-Ins → Communication Add-
in → Always enable this add-in from the displayed menu (as shown in the following figure). 

Figure 10  Outlook Account Information – Add-in Disabled 

Why is presence not showing in the Outlook Add-in? 

If the presence indicator icon is not shown in Outlook, verify any of the following software is installed: 

• Microsoft Office Communicator (OCS)

• Microsoft Lync/S4B

• Skype version 6.1 or above



Clearspan Communicator User Guide for Desktop R22.7.1 

65     |   Clearspan 

Uninstall each one found and restart Outlook and the Communicator client. 

Note: During Office/Outlook 2013 installation, the installer installs Microsoft Lync by 
default.  You must uncheck Microsoft Lync (as shown in the following figure) and 
then proceed with the installation. 

Figure 11  Microsoft Office Installation Example 

How do I disable/enable the Outlook Add-In from Communicator Preferences view? 

To enable/disable Outlook contact presence status (5.1 Presence in Outlook), from the 
Communicator Preference page, the “Outlook Add-in, Gateway process” check box option must be 
checked/unchecked. 

To enable/disable the Outlook context menu related to the add-in, from the Communicator Preference 
page, the “Outlook Add-in” check box option must be checked/unchecked. 

Why are Outlook Add-in IM buttons sometimes are greyed out in the quick contact page, even 
though the user is logged in? 

Sometimes IM buttons are greyed out on the contact page.  When mouse over it, it shows the 
message “To use this feature, sign in to an instant messaging program". 

Figure 12  Outlook Add-in IM Buttons Issue 

This seems to be a Microsoft issue, and the workaround to solve is to restart Outlook 
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APPENDIX A:  KEYBOARD SHORTCUTS FOR 
DESKTOP 

The following table lists the currently supported keyboard shortcuts.  You can use these 
keyboard shortcuts to quickly perform frequently used actions. The characters used are lower 
case.  The shortcuts are also indicated in the accessibility menus. 

SHORTCUTS 
FOR 
WINDOWS 

SHORTCUTS 
FOR MAC 

WHAT IT DOES 

CTRL-Q Cmd-Q This quits the application. 

CTRL+F4 Cmd-W This closes the selected window (except for a contact card and 
the About window). 

CTRL+C Cmd-C This copies selected text from Clearspan Communicator to the 
clipboard. 

CTRL+V Cmd-V This pastes text from the clipboard to the location selected using 
the cursor in Clearspan Communicator. 

CTRL+X Cmd-X This cuts the selected text to the clipboard. 

Enter Enter When in the Communications window, this sends a chat message 
(if the Chat view is visible). 

When in the contact list, this opens a chat with the selected 
contact. 

When in the Communications History, this opens a 
communications session with the contact or address related to the 
selected item.  This opens a chat if the item was chat and a call if 
the item was a call. 

- Cmd-, This opens Preferences. 

F1 Cmd-? This opens Help. 

CTRL+A Cmd-A This selects all text in the Chat view. 

- Cmd-H This hides Communicator. 

- Alt-Cmd-H This hides other windows other than Communicator. 

CTRL-N Cmd-N This opens the Add Contact window. 

Shift-CTRL-N Shift-Cmd-N This opens the Add Group window. 

CTRL -1 Cmd-1 When a contact is selected, this opens a chat session with the 
contact. 

CTRL -2 Cmd-2 When a contact is selected, this calls the contact with audio. 
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SHORTCUTS 
FOR 
WINDOWS 

SHORTCUTS 
FOR MAC 

WHAT IT DOES 

CTRL -3 Cmd-3 When a contact is selected, this calls the contact using call from 
phone. 

CTRL -4 Cmd-4 When a contact is selected, this calls the contact with video. 

CTRL -5 Cmd-5 When a contact is selected, this joins his room. 

CTRL -6 Cmd-6 When a contact is selected, this opens an email-sending window 
using the default email client. 

CTRL -I Cmd-I When a contact is selected, this opens the contact card for the 
contact. 

Shift-CTRL-F Shift-Cmd-F When a contact is selected, this makes the contact a favorite. 

CTRL-delete Cmd-delete This deletes the selected contact. 

CTRL-arrow 
down 

Cmd-arrow 
down 

This decreases the volume. 

CTRL-arrow up Cmd-arrow up This increases the volume. 

CTRL-space CTRL-space This mutes the client (while in a call). 

CTRL-D Cmd-D This turns on the Do Not Disturb service. 

CTRL-P Cmd-P This pulls an ongoing call from your other device to 
Communicator. 

Alt-shift- CTRL-
P 

Alt-shift-Cmd-P This retrieves your parked call. 

- Alt-Cmd-2 This calls your voice mail with audio. 

- Alt-Cmd-3 This calls your voice mail with audio using call from phone. 

- Alt-Cmd-4 This calls your voice mail with video. 

Shift-CTRL-R Shift-Cmd-R This opens your My Room. 

CTRL-M Cmd-M This minimizes the window on MAC OS.  On Windows, it only is 
used for the Team Telephony window. 

CTRL-T Cmd-T This enables always on top. 

- Shift-Cmd-M This opens the Main window. 

Shift-CTRL-C Shift-Cmd-C This opens contacts. 

Shift-CTRL-F2 Shift-Cmd-F2 This opens call history. 

Shift-CTRL-F1 Shift-Cmd-F1 This opens chat history. 
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SHORTCUTS 
FOR 
WINDOWS 

SHORTCUTS 
FOR MAC 

WHAT IT DOES 

Shift-CTRL-F3 Shift-Cmd-F3 This opens visual voice mail. 

Shift-CTRL-D Shift-Cmd-D This opens the dial pad view. 

Shift-CTRL-W Shift-Cmd-W This opens the web button view. 
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APPENDIX B:  GUEST CLIENT USAGE 

This section provides more hands-on information about guest client usage. 

1. Right-click on the My Room icon to copy the guest join link and send it to a guest via
email or other means. You can also select My Room Invitations from the Conversations
menu to send the guest join link.

Figure 13  Copy Guest Join Link Menu Option 

2. The guest can open the link in one of the supported browsers, enter their name and
password, and then click Join Room.

Figure 14  Login Screen for Join Room 

3. Once you click on Join Room, you see a badge on your My Room icon (as shown in the
following figure).
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Figure 15  My Room Icon – Guest Request Badge 

4. Open your My Room and accept the guest request.

Figure 16  My Room – Accept Guest Request 

You can also accept or decline join requests from the pop-up notification as shown in the 
following figure.  This pop-up notification is shown only if you already have your My Room open. 

Figure 17  Accept/Decline Request Pop-Up 

5. The guest is allowed into your room and can now participate in multi-user chat with other
participants in the room.

If your service provider has enabled WebRTC support, then the guest can join the audio/video 
portion of the session by clicking on the audio or video button.  This feature is only available on 
certain browsers and the user must grant access to their camera and microphone by clicking 
Allow. 

The guest can switch between audio and video mode by clicking on the video icon.  They can 
also mute and end the call by clicking on the mute and end call icons respectively. 

The guest can show or hide their self-view by clicking on the  icon in the top left corner of the 
video. 
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You can start your desktop share from the Desktop client and the guest then sees it.  The video 
call is resized and moved to the top left. 

The guest can also request the conference bridge to call them by entering a phone number and 
clicking on the CALL ME button.  The Call Me Now feature must be enabled by your service 
provider for this to be available. 

The guest can also manually call the conference bridge directly by using the provided dial-in 
information. 



Clearspan Communicator User Guide for Desktop R22.7.1

72     |   Clearspan 

APPENDIX C:  SKYPE FOR BUSINESS 
INTEGRATION 

This section provides more hands-on information about Skype for Business (S4B) integration 
usage. 

The required startup procedure is as follows (reversing the order in which S4B and 
Communicator are started will not work): 

1. Start S4B.

2. Start Communicator.  You can have it minimized or in the foreground.  Your service
provider may also choose an automatic “Minimize after login” feature that automatically
minimizes Communicator after login.

By default, when making a PSTN call from S4B while UC-One is minimized, UC-One comes 
to the foreground for the duration the call and is then auto-minimized after call except in the 
following cases: 

• Chat has been used during the call (chat may continue)

• Window size has been changed

• Active view has been changed (for example, from contacts to dial pad)

Clearspan Mobile/Tablet does not minimize after an incoming PSTN call to Clearspan 
Mobile/Tablet unless configured to do so by your service provider.  In addition, by default, if 
Clearspan Mobile/Tablet is in the task bar before the call, then it does not auto-minimize. 

When auto-minimizing after call is enabled by your service provider, Communicator is sent to 
the background “closed”, so that you can only access it through the system tray.  If 
Communicator is either minimized or in the background when call is triggered outside of 
Communicator, or a call is answered with Communicator, upon terminating the last call, 
Communicator is sent to the background. 

All other communications related to that call, such as chat, are terminated and the 
tab/communications window is closed prior to sending Communicator to the background.  
This happens regardless if you are engaged in ongoing chats, share, or other activities inside 
or outside the last call that terminated. 

If Communicator is brought to the foreground manually this new behavior does not apply. 

The original intended use case for S4B integration was to use S4B for presence and chat and 
on-net (VoIP) calls while Communicator would be used for off-net calls with presence and 
chat turned off.  However, many deployments keep the full presence and chat functionality of 
Communicator.  Communicator supports presence synchronization between S4B and 
Communicator for most presence statuses. 

The following sections describe the ways to make various kinds of calls. 

ON-NET CALLING 

To make an on-net call: 

1. Select a S4B contact and click the call button.  Alternatively, right-click a contact and
select an on-net number.
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2. Both the S4B main window and communications window are visible (as shown in the
following figures).

Figure 18  Making an On-Net Call 

Figure 19  Ongoing On-Net Call 

OFF-NET CALLING 

Off-net calling has more variations due to S4B remembering the last number used to call a 
contact when clicking the call button (default action).  As a result, when in S4B calling another 
S4B contact who is, for example, offline or in DnD status, using the call button (where the default 
action is to call an S4B address) will fail and the S4B call will not complete. 

Your service provider can configure Communicator to make the call instead in these cases. 

To make an off-net call: 



Clearspan Communicator User Guide for Desktop R22.7.1

74     |   Clearspan 

1. Select a contact, right-click and select an external number (see the following list for the
possible selections).  The same outcome occurs when making an S4B-to-S4B call while
the called person is, for example, offline or in the DnD state.  Selecting a particular
number from the right-click menu will call that number, while using the call button only
selects the number to be called.  The order in which the number is selected in this case is
listed as follows and cannot be changed:

• Work phone

• Mobile phone (can also be two mobile numbers)

• Home phone

• Other phone

• S4B voice mail

2. Communicator attempts to make the call instead of S4B.  Both the S4B main window and
Communicator communications window are visible.

Figure 20  Making an Off-Net Call 
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Figure 21  Ongoing Off-Net Call 

PRESENCE SYNCHRONIZATION 

When Communicator is configured to have full presence functionality and to also act in S4B 
integration mode, making a call in Communicator may automatically change Communicator 
presence to Busy –In Call.  In this case, a similar presence status is automatically selected on 
the S4B side and vice versa. 

The same principle also applies to other presence statuses.  Changing presence on the S4B 
side is detected by Communicator and a similar presence state is automatically shown on the 
Communicator side.  Note that the different presence statuses used in S4B and Communicator 
are not 100% the same so an exact mapping is not possible.  However, a status variant is 
matched to a similar status variant on the other client.  For example, a busy status variant would 
be matched to a busy status variant. 
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APPENDIX D:  USB HEADSET CONFIGURATION 

This section provides more information on configuring USB devices to function with 
Communicator. 

In general on Windows, if “Default Communication Device” is defined in Windows settings, it is 
selected over the “Default Device” by Communicator for calls when several audio devices are 
available (for example, USB headset and the integrated audio device on the PC).  However, 
when using headsets, you can select a separate device than the headset for alerting incoming 
calls. 

The following examples provide more information on how to define a default communications 
device when a USB headset is available on the PC. 

It is recommended to select “Use Default” in the Audio tab of Communicator Preferences for 
both input and output devices (as shown in the following figure). 

Figure 22  Preferences Window 
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To define the default communications device, make sure that the Sound settings in Windows 
pertaining to “Recording” and “Playback” devices are correctly configured.  From the Sound 
applet, select the Playback tab. 

Figure 23  Sound Window – Playback Tab 

In this example, the user has a Plantronics BT300M (the USB dongle accompanying a Voyager 
Legend UC) connected to their PC. 
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Click Headset Earphone to highlight the device and click on the drop-down arrow next to the 
Set Default button. 

Figure 24  Sound Window – Playback Tab – Set Default 
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Select Default Communication Device.  The following screen is displayed. 

Figure 25  Sound Window – Playback Tab – Default Set 
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Next, select the Recording tab. 

Figure 26  Sound Window – Recording Tab 
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Again, click on Headset Microphone, which represents the connected Plantronics BT300M 
device, and click on the drop-down arrow next to the Set Default button. 

Figure 27  Sound Window – Recording Tab – Set Default 
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Select Default Communication Device. 

Figure 28  Sound Window – Recording Tab – Default Set 

Click OK to save the changes.  The Sound window is dismissed and your device is now ready to 
be used by Clearspan Communicator. 
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APPENDIX E:  THIRD-PARTY SOFTWARE AND 
COPYRIGHT 

The following third-party software is used in Communicator. 

Chromium 

Copyright (c) 2013 The Chromium Authors. All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer. * Redistributions in binary form must reproduce the above copyright notice, this
list of conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution. * Neither the name of Google Inc. nor the names of its contributors may be used
to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 

WebRTC 

Copyright (c) 2011, The WebRTC project authors.  All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Google nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 



Clearspan Communicator User Guide for Desktop R22.7.1

84     |   Clearspan

CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 

OpenH264 

Copyright (c) 2013, Cisco Systems.  All rights reserved. 

OpenH264 License:  https://github.com/cisco/openh264/blob/master/LICENSE 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 

Blowfish 

Based on a C implementation of the Blowfish algorithm by Paul Kocher 

UUID - RFC4412 

/* 

** Copyright (c) 1990 - 1993, 1996 Open Software Foundation, Inc. 

** Copyright (c) 1989 by Hewlett-Packard Company, Palo Alto, Ca. & 

** Digital Equipment Corporation, Maynard, Mass. 

** Copyright (c) 1998 Microsoft. 

** To anyone who acknowledges that this file is provided "AS IS" without any express or implied 
warranty: permission to use, copy, modify, and distribute this file for any purpose is hereby granted 
without fee, provided that the above copyright notices and this notice appears in all source code 
copies, and that none of the names of Open Software Foundation, Inc., Hewlett-Packard Company, 
Microsoft, or Digital Equipment Corporation be used in advertising or publicity pertaining to 
distribution of the software without specific, written prior permission.  Neither Open Software 
Foundation, Inc., Hewlett-Packard Company, Microsoft, nor Digital Equipment Corporation make any 
representations about the suitability of this software for any purpose. 

*/ 

https://github.com/cisco/openh264/blob/master/LICENSE
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MD5 

Copyright (c) 1991-2, RSA Data Security, Inc. Created 1991.  All rights reserved. 

License to copy and use this software is granted provided that it is identified as the “RSA Data 
Security, Inc. MD5 Message-Digest Algorithm” in all material mentioning or referencing this software 
or this function. 

License is also granted to make and use derivative works provided that such works are identified as 
“derived from the RSA Data Security, Inc. MD5 Message-Digest Algorithm” in all material mentioning 
or referencing the derived work. 

RSA Data Security, Inc. makes no representations concerning either the merchantability of this 
software or the suitability of this software for any particular purpose.  It is provided “as is” without 
express or implied warranty of any kind. 

SHA-1 

Copyright (c) The Internet Society (2001).  All Rights Reserved. 

This document and translations of it may be copied and furnished to others, and derivative works that 
comment on or otherwise explain it or assist in its implementation may be prepared, copied, 
published and distributed, in whole or in part, without restriction of any kind, provided that the above 
copyright notice and this paragraph are included on all such copies and derivative works.  However, 
this document itself may not be modified in any way, such as by removing the copyright notice or 
references to the Internet Society or other Internet organizations, except as needed for the purpose of 
developing Internet Standards in which case the procedures for copyrights defined in the Internet 
Standards process must be followed, or as required to translate it into languages other than English. 

The limited permissions granted above are perpetual and are not revoked by the Internet Society or 
its successors or assigns. 

This document and the information contained herein is provided on an “AS IS” basis and THE 
INTERNET SOCIETY AND THE INTERNET ENGINEERING TASK FORCE DISCLAIMS ALL 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTY 
THAT THE USE OF THE INFORMATION HEREIN WILL NOT INFRINGE ANY RIGHTS OR ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

SQLCipher 

Copyright (c) 2008-2012 Zetetic LLC 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the ZETETIC LLC nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY ZETETIC LLC ''AS IS'' AND ANY             EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL ZETETIC LLC BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
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PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT             (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGE. 

Lesser General Public License (LGPL) 

The following third-party libraries are in use based on LGPL license. 

This software uses Qt libraries licensed under the GNU Lesser General Public License (LGPL) 2.1. 

Qjson – Copyright 2012 – Flavio Castelli 

QXmpp – Copyright 2008-2011 The QXmpp developers 

QCA – Copyright 2003-2007 Justin Karneges justin@affinix.com.  Copyright 2004-2006 Brad Hards 
bradh@frogmouth.net 

LGPL license are available at http://www.gnu.org/copyleft/lesser.html. 

LGPL license is also available locally with this software, at the installation directory. 

BSD license 

The following software is used based on BSD license: 

OpenSSL - Copyright 1998-2011.  The OpenSSL Project. 

License available at http://www.openssl.org/source/license.html. 

Breakpad - Copyright 1998, Regents of the University of California 

Breakpad license available at http://opensource.org/licenses/BSD-3-Clause. 

Stackwalker - Copyright 2009, Jochen Kalmbach 

License available at http://stackwalker.codeplex.com/license. 

Apache license 2.0 

The following third-party libraries are using Apache license 2.0: 

Log4cxx - Copyright 2012 Apache Software Foundation. 

License available at http://logging.apache.org/log4cxx/license.html. 

Non-restrictive license 

The following third-party library is used based on its own non-restrictive license: 

OpenLDAP - Copyright 2013, OpenLDAP Foundation. 

OpenLDAP license is available online for review at 
http://www.openldap.org/software/release/license.html. 

OpenLDAP license is also available locally with this software at the installation directory. 

Free software 

The following free software is only used when third-party software is using the Communicator API via 
LGPL, MIT, BSD, or another license: 

Tufao (LGPL2.1) – Copyright 2012 Vinicius dos Santos Oliveira vini.ipsmaker@gmail.com 

mailto:bradh@frogmouth.net
http://www.gnu.org/copyleft/lesser.html
http://www.openssl.org/source/license.html
http://opensource.org/licenses/BSD-3-Clause
http://stackwalker.codeplex.com/license
http://logging.apache.org/log4cxx/license.html
http://www.openldap.org/software/release/license.html
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Libcurl – Copyright 1996 - 2013, Daniel Stenberg, daniel@haxx.se 

License available at http://curl.haxx.se/docs/copyright.html. 

Tinythread++ - Copyright 2012 Marcus Geelnard 

License available at http://opensource.org/licenses/zlib-license.php. 

Picojson – Copyright 2009-2010 Cybozu Labs, Inc. Copyright 2011 Kazuho Oku 

License available at https://github.com/kazuho/picojson/blob/master/LICENSE. 

Easywsclient – Copyright 2012, 2013 dhbaird@gmail.com 

License available at https://github.com/dhbaird/easywsclient/blob/master/COPYING. 

The Qt Toolkit is Copyright (C) 2015 The Qt Company Ltd. 

Contact:  http://www.qt.io/licensing/ 

You may use, distribute and copy the Qt GUI Toolkit under the terms of GNU Lesser General Public 
License version 3. 

This license makes reference to version 3 of the GNU General Public License. 

LGPL license are available at http://www.gnu.org/copyleft/lesser.html. 

http://curl.haxx.se/docs/copyright.html
http://opensource.org/licenses/zlib-license.php
https://github.com/kazuho/picojson/blob/master/LICENSE
https://github.com/dhbaird/easywsclient/blob/master/COPYING
http://www.qt.io/licensing/
http://www.gnu.org/copyleft/lesser.html
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APPENDIX F:  ACRONYMS AND ABBREVIATIONS 

ACB Automatic Callback 

ACD Automatic Call Distribution 

API Application Programming Interface 

CPU Central Processing Unit 

DND Do Not Disturb 

DTMF Dual-tone multi-frequency 

ECACS  Emergency Call Address Change Service 

EULA End-User License Agreement 

FAC Feature Access Code 

FAQ Frequently Asked Question 

FIPS Federal Information Processing Standard 

FMC Fixed-mobile convergence 

GUI Graphical User Interface 

GW Gateway 

HD High Definition 

HID Human Interface Device 

IdP Identity Provider 

IM Instant Message 

IM&P Instant Messaging and Presence 

IP Internet Protocol 

LDAP Lightweight Directory Access Protocol 

LGPL Lesser General Public License 

MWI Message Waiting Indication 

PIV Personal Identity Verification 

RAM Random Access Memory 

S4B Skype for Business 

SAML Security Assertion Markup Language 
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SIP Session Initiation Protocol 

UC Unified Communications 

UI User Interface 

URL Uniform Resource Locator 

UVS Video Server 

VDI Virtual Desktop Infrastructure 

VoIP Voice over IP 

WebRTC Web Real-Time Communication 

XMPP Extensible Messaging and Presence Protocol 

Xsi Xtended Services Interface 
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